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About Your DNA Samples
SAMPLE CRITERIA

Genomic DNA Sample Criteria

• Concentration
All genomic DNA samples should be normalized to a single concentration of 
150 ng/μL using 1X TE buffer. The Kit Control DNA included in every Affymetrix 
GeneChip® SNP Kit has already been normalized to a working concentration.

• Minimum volume of DNA required

- For assay panels that are 5K and lower: 2 μg in approximately 15 μL of 1X TE 
Buffer

- For assay panels greater than 5K: 4 μg in approximately 30 μL of 1X TE Buffer

• Buffer: 1X TE buffer

• Extraction and purification methods

- QIAGEN; QIAamp DNA Blood Maxi Kit

- Phenol-chloroform extraction

- Gentra PUREGENE

GENERAL REQUIREMENTS

Genomic DNA samples to be processed using GeneChip SNP Kits must:

• Not be amplified.

• Be free of inhibitors. 
The extraction and purification method should render genomic DNA that is 
generally salt-free. High concentrations of certain salts can inhibit enzyme reactions.

• Not be contaminated with other human genomic DNA sources or with genomic 
DNA from other organisms.

• Not be highly degraded.

SOURCES OF GENOMIC DNA

The following sources of genomic DNA have been successfully processed with 
GeneChip SNP Kits in our laboratories:

• Blood

• Cell line

• Semen

• Tissue including brain, liver and spleen
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About the Protocol

PROTOCOL OVERVIEW

One full run of the MIP Assay Protocol (not including data analysis) requires 
approximately 2.5 days. The protocol is performed in two physically separated labs 
referred to in this guide as the Pre-Amp Lab and the Post-Amp Lab. Separate rooms 
are required to prevent contamination of sample DNA with amplified products from 
previous reactions. To process samples at a throughput of 48 samples per day; 192 
samples per 5 day week, at least two full-time employees (Research Assistants) are 
required.

Recommendations for when to perform the various stages of the protocol are shown in 
Figure 1.1 and Figure 1.2.

Figure 1.1
Recommended Workflow for Processing 48 Samples Per Day
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Figure 1.2
Recommended Timing for Stages of the Protocol
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GeneChip® SNP Kits

CONTENTS AND STORAGE CONDITIONS

GeneChip SNP Kits consist of the reagents and other components. One kit is 
sufficient to process 24 reactions (including 1 control).

Kit components are shipped in multiple boxes. Because the various components must 
be stored under different conditions, be sure to read each label to ensure that reagents 
are properly stored.

Kit Components Used in the Pre-Amp Lab

The kit components listed in Figure 1.3 and Figure 1.4 are used in the Pre-Amp Lab 
and should be stored at –20°C.

Figure 1.3
Assay Panel Box — Store at –20°C

Figure 1.4
Pre-Amp Box — Store at –20°C

Assay Panel Box

1 tube each of the following:
• Assay Panel . . . . . . . 160 µL

• Kit Control DNA . . . . .70 µL

Note: This box will contain two assay 
panel tubes if you are using a Special 
Edition panel.

1 tube each of the following:
• Enzyme A . . . . . . . . . . . . . . . . 60 µL

• Buffer A . . . . . . . . . . . . . . . . . 200 µL

• Water . . . . . . . . . . . . . . . . . . . . .2 mL

• Gap Fill Mix . . . . . . . . . . . . . . 130 µL

• Exo Mix . . . . . . . . . . . . . . . . . 530 µL

• Cleavage Tube . . . . . . . . . . . 3000 µL

• Cleavage Enzyme. . . . . . . . . . . .30 µL

• Amp Mix . . . . . . . . . . . . . . . . 3000 µL

• 1 plate dNTP Mix (20 µL per well)

Pre-Amp Box
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Kit Components Used in the Post-Amp Lab 

The kit components listed in Figure 1.5, Figure 1.6 and Figure 1.7 are used in the 
Post-Amp Lab. Post-Amp Box 1 kit components should be stored at –20°C.

The Stain Cocktail (Figure 1.6) is shipped in a box labeled Stain Kit .

Wash Solution Kit contents (Figure 1.7) should be stored in the Post-Amp Lab at 
room temperature.

Figure 1.5
Post-Amp Box 1 — Store at –20°C

Even if the Stain Cocktail arrives frozen, it must be stored at 2–8°C.

Figure 1.6
Stain Kit Box — Store at 2–8°C

Figure 1.7
Wash Solution Kit — Store at room temperature

1 tube each of the following:
• HY A Allele Tube . . . . . . . . . . . 950 µL

• HY C Allele Tube . . . . . . . . . . . 950 µL

• HY G Allele Tube . . . . . . . . . . . 950 µL

• HY T Allele Tube . . . . . . . . . . . 950 µL

• HY Digest Mix . . . . . . . . . . . . . 260 µL

• Buffer H . . . . . . . . . . . . . . . . . . 330 µL

• Hyb Cocktail . . . . . . . . . . . . . . .900 µL

Post-Amp Box 1

Stain Cocktail . . . . . 5 mL

Stain Kit Box

• Wash Solution A . . . . . . . . 500.0 mL
• Wash Solution B . . . . . . . . 500.0 mL

Wash Solution Kit Contents
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Taq Polymerase Required

TAQ POLYMERASE

The MIP Assay Protocol has been optimized with and requires the use of following 
two Taq polymerases:

For Clontech and Stratagene contact information, refer to Appendix A, Vendor Contact 
Information.

Preventing Sample Contamination

GUIDELINES FOR PREVENTING SAMPLE CONTAMINATION

To prevent sample contamination, we strongly suggest everyone entering the Pre- and 
Post-Amp Labs follow these guidelines:

• Never bring any items that have been in the Post-Amp Lab into the Pre-Amp Lab. 
Always assume that all surfaces in the Post-Amp Lab are contaminated with 
amplified PCR product, and that all items that enter the Post-Amp Lab become 
contaminated with product.

• Keep dedicated lab coats for the Pre-Amp Lab and the Post-Amp Lab.

• Use proper gowning procedures.

• Always wear gloves when handling equipment or samples in either lab.

• Do not move equipment between the Pre- and Post-Amp Labs. Keep dedicated 
equipment in both labs.

• Print separate copies of the protocol for each lab.

• If both labs are connected by a door, do not return to the Pre-Amp Lab via the Post-
Amp Lab.

Supplier Description/Part Number Amount/Vial

Clontech TITANIUM™ / 639208 100 rxns

(100 µL sufficient to process 24 reactions) TITANIUM / 639209 500 rxns

Stratagene
(sufficient to process 48 reactions)

TAQ Polymerase / 929197 200 µL
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About Using Control DNA

ABOUT THE CONTROL DNA

The control DNA supplied in each GeneChip SNP Kit has been normalized to a 
working concentration. No further dilution or concentration is required.

RECOMMENDATIONS FOR USAGE

To ensure the highest quality data, we strongly recommend running one positive 
control for every 23 samples. Control DNA is included in every GeneChip SNP Kit.

Our protocol is written such that the control is always placed in column 12 of the PCR 
plates (Anneal, Assay, Label and Hyb).

BENEFITS OF USING CONTROLS

Running control DNA is important for quality control and troubleshooting purposes. 
Using controls can help you more quickly resolve issues related to:

• Sample quality

• Assay performance
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Important Notice Regarding Product Support
ABOUT QUALIFYING FOR SUPPORT

The MIP Assay Protocol has been optimized for use on the Affymetrix GeneChip® 
Scanner 3000 Targeted Genotyping System (GCS 3000 TG System) using the 
equipment, supplies and consumables listed in this chapter.

About the Equipment, Supplies and Consumables Required

How the Information Is Organized

Information on the equipment, supplies and consumables required is organized as 
follows:

• Equipment and Software Supplied by Affymetrix for Standard System Configuration

• Equipment, Supplies, and Consumables Required But Not Provided

- Equipment Required But Not Provided

- Supplies Required But Not Provided

- Consumables Required But Not Provided

- Quality Control Gels

A double asterisk (**) next to an item indicates that no substitutions can be made.
To qualify for support, these particular items must be used. In addition, training will
be conducted only when all of the equipment, supplies and consumables are
verified as present and properly installed.
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Equipment and Software Supplied by Affymetrix for Standard 
System Configuration

The following items are shipped to your facility directly from Affymetrix. A double 
asterisk (**) next to an item indicates that no substitutions can be made.

Do not unpack any of the equipment supplied by Affymetrix. An Affymetrix
representative will unpack, install and verify the operation of the equipment and
software.

Store GeneChip® Universal Tag Arrays at 4°C.

Table 2.1
Equipment and Software Supplied by Affymetrix for Standard System Configuration

Item Quantity Part Number Laboratory 
Location

** Affymetrix GeneChip® Scanner 3000 Targeted Genotyping 
System including:

- GeneChip® Scanner 3000 7G 4C with 7G Instrument Control 
Workstation

- GeneChip® Scanner 3000 Autoloader with 2D barcode reader
- GeneChip® Fluidics Station 450
- GeneChip® Hybridization Oven 640 with carriers
- GeneChip® Operating Software (GCOS), v1.4
- GeneChip® Targeted Genotyping Analysis Software, v1.5
- TG Pre-Amp Lab Workstation with 2D barcode reader
- TG Post-Amp Lab Workstation with SQL Server 2000 Standard 

Edition license and 2D barcode reader

1 00-0185 Pre and Post-Amp 
Labs

** The following GeneChip® Universal Tag Arrays as appropriate:

- GeneChip® Universal 3K Tag Array As required 900602 (6 pk)
Post-Amp Lab

900578 (96 pk)

- GeneChip® Universal 5K Tag Array As required 900659 (6 pk)
Post-Amp Lab

900660 (96 pk)

- GeneChip® Universal 10K Tag Array As required 900604 (6 pk)
Post-Amp Lab

900580 (96 pk)

- GeneChip® Universal 25K Tag Array As required 900857 (6 pk)
Post-Amp Lab

900858 (96 pk)



12 Affymetrix GeneChip® Scanner 3000 Targeted Genotyping System User Guide
Equipment, Supplies, and Consumables Required But 
Not Provided

VENDOR CONTACT INFORMATION

See Appendix A for vendor contact information.

EQUIPMENT REQUIRED BUT NOT PROVIDED

Table 2.2
Equipment Required but not Provided

Equipment Quantity Manufacturer/
Distributor

Part Number
(U.S.)

Laboratory 
Location

** Thermal Cyclers – see Table 2.3 on page 13 for a list of thermal cyclers that have been validated for use with the MIP Assay 
Protocol

Eppendorf® Multipurpose Centrifuge 5804 2 VWR Intl. 53513-800 1 Pre-Amp Lab
1 Post-Amp Lab

Eppendorf® Deepwell Swing Bucket Rotor with two 
buckets 

2 VWR Intl. 77888-214 1 Pre-Amp Lab
1 Post-Amp Lab

Mini Vortexer, analog 2 VWR Intl. 58816-121 1 Pre-Amp Lab
1 Post-Amp Lab

Galaxy Mini Centrifuge (interchangeable for 
microtubes and strip tubes)

4 VWR Intl. 37000-700 2 Pre-Amp Lab
2 Post-Amp Lab

** Aluminum Block, 96-well 4 BioSmith 81001 Pre-Amp Lab

** Pipettes and pipette tips — see Table 2.4 on page 14 for a list of pipettes and tips that have been validated for use with the 
MIP Assay Protocol

Carousel Stand for Rainin® Pipettes 4 Rainin CR-7 2 Pre-Amp Lab
2 Post-Amp Lab

Portable Pipet-Aid (110V) 1 VWR 53498-103 Post-Amp Lab

Freezer, –20°C; deep freeze; manual defrost; 17 cu ft 2 — — 1 Pre-Amp Lab
1 Post-Amp Lab

Refrigerator, 4°C refrigerator; 6 cu ft 2 — — 1 Pre-Amp Lab
1 Post-Amp Lab
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Thermal Cyclers

To run the MIP Assay Protocol at a throughput of 48 assays/day, you will need 4 
thermal cyclers: 2 in the Pre-Amp Lab; 2 in the Post-Amp Lab. 

The MIP Assay Protocol has been optimized using GeneAmp® PCR System 9700 
Thermal Cyclers (96-well, gold-plated). The additional thermal cyclers listed in Table 
2.3 have been validated for use with the protocol in the laboratory location specified.

Table 2.3
Thermal Cyclers Validated for Use With the MIP Assay Protocol

Note the laboratory location for the thermal cyclers listed in Table 2.3. Some of
these instruments can be used in the Post-Amp Lab only.

Manufacturer/
Distributor

Item Part Number
(U.S.)

Laboratory Location

Applied 
Biosystems 

Thermal Cyclers

GeneAmp® PCR System 9700 Thermal Cycler, 
96-well, Silver

N8050001

Use in both the Pre- 
and Post-Amp Labs

GeneAmp® PCR System 9700 Thermal Cycler, 
96-well, Gold-plated

4314878

GeneAmp® PCR System 9700 Thermal Cycler, 
96-well, Aluminum

4314879

GeneAmp® PCR System 9700 Thermal Cycler, 
Dual 96-well

4343176 Use in Post-Amp Lab 
only

BioRad 
Thermal Cyclers

DNA Engine® Peltier Thermal Cycler
chassis only; requires 1 Alpha Unit (see BioRad Alpha Units 
below)

PTC-0200

Use in Post-Amp Lab 
only

DNA Engine Dyad® Peltier Thermal Cycler
chassis only; requires 2 Alpha Units (see BioRad Alpha Units 
below)

PTC-0220

DNA Engine Dyad® Peltier Thermal Cycler
Disciple chassis only; requires 2 Alpha Units (see BioRad 
Alpha Units below)

PTC-0221

DNA Engine Tetrad® 2 Peltier Thermal Cycler
Chassis only; requires 4 Alpha Units (see BioRad Alpha Units 
below)

PTC-0240

BioRad 
Alpha Units

Alpha™ Unit: Holds 96 x 0.2 ml tubes or one 96-well plate ALS-1296

Moto Alpha™ Unit: Holds one 96-well plate with integrated 
motorized heated lid

ALP-2296
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Pipettes and Pipet Tips

To run the MIP Assay Protocol, you will need the following types of pipettes. The 
pipettes and tips validated fro use with the MIP Assay Protocol are listed in Table 2.4.

• Single channel pipettes

- 0.1–2 μL

- 0.5–10 μL

- 2–20 μL

- 20–200 μL

- 100–1000 μL

• 12-channel pipettes

- 0.5–10 μL or 1–20 μL

- 2–20 μL, 5–50 μL, 20–200 μL or 20–300 μL

• 24-channel pipettes, electronic or manual

- 2–20 μL

- 10–100 μL
Table 2.4
Pipettes and Pipet Tips Validated for Use With the MIP Assay Protocol

Manufacturer/
Distributor

Item Quantity Part Number
(U.S.)

Laboratory 
Location

SINGLE CHANNEL MANUAL PIPETTES

Rainin®

Pipet-Lite™ LTS™ Pipet, 0.1–2 µL 1 L-2 1 Pre-Amp Lab

Pipet-Lite LTS Pipet, 0.5–10 µL 2 L-10 1 Pre-Amp Lab
1 Post-Amp Lab

Pipet-Lite LTS Pipet, 2–20 µL 2 L-20 1 Pre-Amp Lab
1 Post-Amp Lab

Pipet-Lite LTS Pipet, 20–200 µL 2 L-200 1 Pre-Amp Lab
1 Post-Amp Lab

Pipet-Lite LTS Pipet, 100–1000 µL 2 L-1000 1 Pre-Amp Lab
1 Post-Amp Lab

Rainin Pipet Tips

(use for single, 12-, 
and 24-channel 
Rainin pipettes)

LTS™ Pipette Tips, P-1000 barrier 
(8 racks of 96 tips each; 768 tips per box)

As 
required

RT-L1000F
(1 box)

Pre and Post-Amp 
Labs

LTS Pipette Tips, P-200 barrier 
(10 racks of 96 tips each; 960 tips per box)

As 
required

RT-L200F
(1 box)

LTS Pipette Tips, P-10 barrier 
(10 racks of 96 tips each; 960 tips per box)

As 
required

RT-L10F
(1 box)
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12-CHANNEL MANUAL PIPETTES

Rainin Pipettes

Pipet-Lite LTS 12 Channel Pipet, 0.5–10 µL 2 L12-10 1 Pre-Amp Lab
1 Post-Amp Lab

Pipet-Lite LTS 12 Channel Pipet, 2–20 µL 2 L12-20 1 Pre-Amp Lab
1 Post-Amp Lab

Pipet-Lite LTS 12 Channel Pipet, 20–200 µL 2 L12-200 1 Pre-Amp Lab
1 Post-Amp Lab

Gilson Pipettes
Pipetman® Ultra, U12-20, P20, 1–20 µL 2 F21041 1 Pre-Amp Lab

1 Post-Amp Lab

Pipetman Ultra, U12-300, 20–300 µL 2 F21043 1 Pre-Amp Lab
1 Post-Amp Lab

Gilson Pipet Tips

Gilson Diamond® sterilized extra long filter tips, 
2-200 µL

As 
required

D200ST
Pre- and Post-Amp 

Labs
Gilson Diamond sterilized filter tips, 30–300 µL As 

required
DF300ST

Eppendorf Pipettes
Research®Series 2100, 0.5–10 µL 2 022453947 1 Pre-Amp Lab

1 Post-Amp Lab
Research Series 2100, 10–100 µL 2 022453963

Eppendorf Pipet 
Tips

epT.I.P.S. Filter, 0.1–10 µL As 
required

022491211
Pre- and Post-Amp 

Labs
epT.I.P.S. Filter, 2–100 µL As 

required
022491237

24-CHANNEL PIPETTES, MANUAL AND ELECTRONIC
Manual or electronic 24 channel pipettes can be used. Electronic recommended for better uniformity when mixing.
A minimum and maximum quantity of electronic pipettes is listed. If using the minimum, you will have to reprogram the 
pipettes throughout the protocol. If using the maximum, you will not have to reprogram the electronic pipettes.

Rainin

2–20 µL
1 Pre-Amp Lab
1 Post-Amp Lab- Pipet-Lite LTS 24 Channel Pipet (manual) 2 L24-20

- EDP3™ + Elect LTS™ Pipet 24 Channel 
(electronic)

2 to 4 E24-20

10–100 µL
1 Pre-Amp Lab
1 Post-Amp Lab- Pipet-Lite LTS 24 Channel Pipet (manual) 2 L24-100

- EDP3+ Elect LTS Pipet 24 Channel (electronic) 2 to 4 E24-100

E3 Rapid Charge Stand 2 or 4 E3-RCS

Manufacturer/
Distributor

Item Quantity Part Number
(U.S.)

Laboratory 
Location
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SUPPLIES REQUIRED BUT NOT PROVIDED

Table 2.5
Supplies Required but not Provided

Small Supplies Quantity Manufacturer/
Distributor

Part Number Laboratory 
Location

Cube Rack, polypropylene (4/pack) 2 packs VWR Intl. 60985-444 1 Pre-Amp Lab
1 Post-Amp Lab

MicroTube Rack, 80-well (5/pack) 2 packs VWR Intl. 10011-284 1 Pre-Amp Lab
1 Post-Amp Lab

96-place rack for 0.2 mL tubes (5/pack) 3 packs USA Scientific 2300-9602 Pre- and Post-
Amp Labs

Preparation racks for PCR thin-walled tubes 
(assorted colors)

1 case Fischer Scientific 05-541-55 Pre- and Post-
Amp Labs

MiniAlarm Timer/Stopwatch 2 VWR Intl. 62344-585 1 Pre-Amp Lab
1 Post-Amp Lab

Lab Coats, dedicated 8 — — Pre and 
Post-Amp Labs

Optional: Ice Bucket, red

Note: You will need an ice bucket dedicated to the 
Post-Amp Lab.

1 VWR Intl. 35751-205 Post-Amp Lab

Optional: Ice Container, red (8.5” x 16” x 3”)

Note: You will need an ice container dedicated to the 
Post-Amp Lab.

1 VWR Intl. 35751-216 Post-Amp Lab

Optional: Ice Container, green (8.5” x 16” x 3”)

Note: You will need an ice container dedicated to the 
Pre-Amp Lab.

1 VWR Intl. 35751-218 Pre-Amp Lab

Calculator 2 — — 1 Pre-Amp Lab
1 Post-Amp Lab

Scissors 2 pairs — — 1 Pre-Amp Lab
1 Post-Amp Lab

Distilled, deionized water supply or carboys (for 
cleaning the fluidics station)

— — — Post-Amp Lab
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CONSUMABLES REQUIRED BUT NOT PROVIDED

Affymetrix GeneChip® SNP Kits

One GeneChip SNP Kit includes reagents sufficient to process 24 reactions. The 
specific kit required to process your samples is determined by the assay panel you are 
using.

Additional Consumables 

The quantities listed for consumables are sufficient to process 600 reactions including 
controls.

Kit components are shipped in multiple boxes. Store each box as directed on the
label.

Table 2.6
Additional Consumables – Quantities sufficient to process approximately 600 reactions

Item Quantity Manufacturer
/Distributor

Part Number 
(U.S.)

Laboratory 
Location

** Both of the Taq DNA Polymerases listed below are 
required.

- Stratagene Taq DNA Polymerase, 200 µL/vial As needed Stratagene 929197
(1 vial)

 Pre-Amp Lab

- Clontech TITANIUM™ Taq Polymerase

100 rxn size is sufficient for processing 24 reactions 
(with 10% extra)

As needed Clontech 639208 
(100 rxns)

639209 
(500 rxns)

 Post-Amp Lab

** PCR Plates (96-well) and barcode labels — see PCR Plates on page 18 and Table 2.7 on page 19 for the PCR plate vendors 
and barcode label supplier validated for use with the MIP Assay Protocol.

** Clear Film for Arrays (81 labels/sheet; 10 sheets per pack) 1 pack Affymetrix Post-Amp Lab

** MicroAmp® Clear Adhesive Films (100 films/pk) 3 pks Applied 
Biosystems

4306311
(1 pack)

Pre and Post-
Amp Labs

Pipettes, 5 mL, disposable, individually wrapped (200/case) 1 case VWR 20171-046 Post-Amp Lab

Pipettes, 10 mL, disposable, individually wrapped (200/case) 1 case VWR 20171-042 Post-Amp Lab

PCR 12-well Tube Strips with Strip Bubble Caps (80/pack) 1 pk VWR 53509-306
(1 pack)

Pre and Post-
Amp Labs

Eppendorf Color-Coded Safe-Lock Microcentrifuge Tubes, 
amber, 2.0 mL (500/case)

2 cases VWR 20901-541 Post-Amp Lab

Eppendorf Color-Coded Safe-Lock Microcentrifuge Tubes, 
natural, 2.0 mL (500/case)

2 cases VWR 20901-540 Pre and Post-
Amp Labs

Reagent Reservoirs, 50 mL (200/case) 1 case VWR Intl. 53504-035
(1 case)

Pre and Post-
Amp Labs

Microtube Tough Spots® for 0.5–2.0 mL tubes, white 
(1000/roll)

1 roll USA Scientific 9185-0000
(1 roll)

Post-Amp Lab
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PCR Plates

To run the MIP Assay Protocol, you will need a supply of 96-well PCR plates with 
specific barcode labels. To facilitate sample tracking, the plates are referred to using 
specific terminology throughout the various stages of the protocol. These designations 
and the barcode prefix associated with each type of plate is listed below.

• Anneal Plate – ANN barcode

• Assay Plates – ASY barcode

• Label Plates – LBL barcode

• Hyb Plates – HYB barcode

Corning Conical Tubes, 15 mL (500/case) 1 case VWR Intl. 21008-670
(1 case)

Pre and Post-
Amp Labs

Gloves, 100/box 6 boxes — — Pre and Post-
Amp Labs

Bench Pads 1 case VWR Intl. 56616-026 Pre and Post-
Amp Labs

Kimwipes® (12” x 12”) 2 packs VWR Intl. 21905-011
(1 pack)

Pre and Post-
Amp Labs

Marking pens, one of the following types
• Water soluble
• Fluorescent

1 pack Fischer 
Scientific

13-380-15A 
or 

13-384

Post-Amp Lab

Marking pens, permanent, fine point, assorted colors 12 pens — — 6 Pre-Amp Lab
6 Post-Amp 

Lab

Razor blades 1 pack — — Post-Amp Lab

Aluminum foil 1 roll — — Post-Amp Lab

Compressed air (canned) 2 cans — — Post-Amp Lab

Tacky Floor Mats 1 case VWR Intl. 12777-112
(1 case)

Post-Amp Lab

If you purchase plates from a vendor other than Axygen, you must purchase
barcode labels from Axygen to apply to your plates. The plates supplied by Axygen
come with the barcode labels already affixed to them.

Table 2.6
Additional Consumables – Quantities sufficient to process approximately 600 reactions

Item Quantity Manufacturer
/Distributor

Part Number 
(U.S.)

Laboratory 
Location
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Table 2.7
PCR Plates and Barcode Labels Validated for Use With the MIP Assay Protocol – Quantities sufficient to process approximately 
600 reactions

QUALITY CONTROL GELS

Training Requirements

As part of the training session, quality control (QC) gels are run on each plate of 
samples processed. Running QC gels helps the trainer determine the source of issues 
that may arise.

Your laboratory must have gel electrophoresis capability and a gel imaging system. 
Gel recommendations are listed below.

QC Gel Recommendations

We recommend running two QC gels per assay:

• While learning to run the MIP Assay Protocol

• For troubleshooting purposes

Manufacturer/
Distributor

Item Quantity Part Number
(U.S.)

Laboratory 
Location

PCR PLATES

Axygen 
distributor

 Anneal PCR Plates, 96-well thin-wall 
(with ANN barcode affixed; 50/case)

1 case 321-63-ANN
(1 case)

 Pre-Amp Lab

Assay PCR Plates, 96-well thin-wall 
(with ASY barcode affixed; 50/case)

1 case 321-63-ASY
(1 case)

 Pre-Amp Lab

Label PCR Plates, 96-well thin-wall 
(with LBL barcode affixed; 50/case)

1 case 321-63-LBL
(1 case)

 Post-Amp Lab

Hybridization PCR Plates, 96-well thin-wall 
(with HYB barcode affixed; 50/case)

1 case 321-63-HYB
(1 case)

Post-Amp Lab

Greiner 

(from E & K 
Scientific)

PCR Plate, 96 Well, Half Skirt 
(no barcode; 40/case)

Note: If purchasing Greiner plates, you must also 
purchase barcode labels from Axygen (listed 
below)

8 cases EK-19280 Pre- and Post-
Amp Labs

BARCODE LABELS

Axygen 
distributor

Barcode Labels for Sample Plates

As 
required

BC-LABEL-SMP Pre-Amp Lab

Barcode Labels for Anneal Plates BC-LABEL-ANN Pre-Amp Lab

Barcode Labels for Assay Plates BC-LABEL-ASY Pre-Amp Lab

Barcode Labels for Label Plates BC-LABEL-LBL Post-Amp Lab

Barcode Labels for Hyb Plates BC-LABEL-HYB Post-Amp Lab
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Precast Gel Recommendations

We recommend using one of the following precast gels and gel system:

Biorad Precast Gels and Gel Box System

Invitrogen Precast Gels and Gel System

Self-Cast Gel Recommendations

If casting your own gels, we recommend following these guidelines:

• Use acrylamide or a high-resolution agarose.

• For agarose gels, we recommend preparing a 4% Agarose SFR gel using 
Agarose SFR by Amresco, part number J234-100G.

Table 2.8
Recommended Biorad Precast Gels and Gel Box System

Item Part Number For Training Ongoing

Wide Mini ReadySub-Cell GT Cell 170-4489 Two cells required to 
concurrently run two gels 

Two cells required to 
concurrently run two gels

ReadyAgarose 96 Plus 3% TBE Gel 161-3062 8 gels 1 gel/24 assays

Table 2.9
Recommended Invitrogen Precast Gels and Gel System

Item Part Number For Training Ongoing

Power supply and gel tray 
recommendations:
• One Mother Base
• Three Daughter Bases

Mother Base: EB-M03
Daughter Bases: EB-D03

One Mother Base and 
Three Daughter Bases

One Mother Base and 
Three Daughter Bases

E-Gel 48 4% Agarose (8 gels/box) G8008-04 8 boxes 2 gels/24 assays
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Before You Start
STAGES OF THE PROTOCOL

The MIP Assay Protocol is presented and performed in stages. These stages are:

• Stage 1 – Design an Anneal Plate

• Stage 2 – Anneal

• Stage 3 – Plan and Make Assay Plates

• Stages 4 – Gap Fill, dNTP, Ligate, Invert, First PCR

• Stage 5 – Second PCR

• Stage 6 – Target Digest

• Stage 7 – Sample Hybridization

• Stage 8 – Stain and Wash

• Stage 9 – Scan Arrays

To prevent sample contamination from PCR products, stages 1, 2, 3 and 4 are 
performed in the Pre-Amp Lab. The remaining stages are performed in the Post-Amp 
Lab.

NORMALIZE SAMPLES

All genomic DNA samples should be normalized to a single concentration of 
150 ng/μL using 1X TE buffer. The Kit Control DNA included in every 
GeneChip® SNP Kit is already normalized to a working concentration.

Minimum volume of DNA required:

• For assay panels that are 5K and lower: 2 μg in approximately 15 μL of 1X TE Buffer

• For assay panels greater than 5K: 4 μg in approximately 30 μL of 1X TE Buffer

For more information on sample criteria and recommendations, see Sample Criteria on 
page 2.

GENECHIP® SNP KITS AND CONTROL DNA

One GeneChip SNP Kit is sufficient to process 24 reactions (23 samples and 1 
control).

To ensure the highest quality data, we strongly recommend running one positive
control for every 23 samples. Control DNA is included in each GeneChip SNP Kit.
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ENZYMES

The enzymes in GeneChip SNP Kits are temperature sensitive. They must be kept at 
−20°C until used.

For all mixes and cocktails, always add the enzymes last, and add them right before 
you plan to use the mix or cocktail.

VOLUMES FOR MIXES AND COCKTAILS

The volumes specified for each mix or cocktail are given for one of the following:

• 24 or 48 reactions

• 24 or 48 arrays

PIPETS AND PIPETTING RECOMMENDATIONS

The types of pipettes used throughout this protocol are:

• Single channel, manual

• 12-channel, manual

• 24-channel, manual or electronic

When the protocol calls for the use of 24-channel pipettes, you can use either a manual 
or an electronic pipette. Rainin EDP3-Plus with LTS electronic pipettes are 
recommended for better uniformity when mixing. 

General Pipetting Recommendations

To ensure full volume transfer, check pipette tips after each pickup and dispense. To 
avoid the formation of air bubbles, dispense liquids at the bottom of each well. Always 
use the type and volume of pipette specified in the protocol.

Electronic Pipetting Recommendations

Follow the instructions provided with the pipettes for the dispense/mix program that:

• Allows reagent to be aspirated and dispensed at a set volume

• Mixes automatically upon dispensing wherein the mix volume can be different from 
the dispense volume

Two options are available for tracking the number of mixes when using Rainin EDP3-
Plus electronic pipettes: the counter option, or the beep option (pipette beeps after 
each mix). We recommend using the beep option, since the counter does not start at 
zero with each use. Instead, it counts pipette operations sequentially. Refer to the 
instructions provided with the pipettes for more information.
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QUALITY CONTROL GEL RECOMMENDATIONS

We recommend running quality control gels at two points during the protocol. 
Knowing in advance that a sample will not provide data will save arrays. The purpose 
of each gel is described below.

• Gel 1: Run to identify any samples that did not amplify.
No bands are visible for samples that have not amplified.

• Gel 2: Run to confirm that bands have digested after the target digest stage.

For more information on quality control gels, see:

• First Quality Control Gel on page 75

• Viewing the First Quality Control Gel on page 75

• Second Quality Control Gel on page 81

• Evaluating the Second Quality Control Gel on page 82



chapter 3  |  Running the Protocol 25
Create a Project

PREREQUISITES

Before you can create a project and run the protocol, you must import the following 
into the Affymetrix GeneChip® Targeted Genotyping Analysis Software (GTGS). 

• Array definitions
Array definitions are loaded into the GTGS during system installation. They are also 
stored on the CD-ROM included with the software. See Array Definition Management 
on page 138 for more information.

• Protocol definitions
Protocol barcodes are supplied on the MIP Assay Protocol Barcodes quick reference 
card. See Adding Protocols on page 135 for more information.

SUMMARY OF STEPS

To create a project, you will:

1. Optional: Create a Sample Info file that contains sample information such as 
species and gender. If gender is important to your study, consider creating Sample 
Info files. See About Sample Info Files on page 25.

2. Create at least one Sample Plate file containing sample plate layout information 
(one file per sample plate)

3. Create a new project in GTGS by importing:

- Assay panel file – located on the CD-ROM received with your first shipment of 
GeneChip SNP Kits for a particular assay panel. 

- Genotype settings file – located on the same CD-ROM as the assay panel file

- Sample info files

- Sample plate files

4. Add sample plates to your project

5. Design an anneal plate

ABOUT SAMPLE INFO FILES

Creating a Sample Info file is optional. These files can contain the following 
information:

• Sample name (mandatory) 

• Sample gender (optional)

• Population (optional)

• Species (optional)

If your assay panel can report gender, and if sample gender is important, consider 
creating Sample Info files that include the gender of each sample. This information can 
help troubleshoot sample tracking errors by comparing the known gender with the 
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inferred gender. The inferred gender is called by the software during data analysis. Refer 
to the Affymetrix GeneChip® Targeted Genotyping Analysis Software User Guide for more 
information.

Once a sample info file has been imported, you can add to or update the existing 
information. You can also delete sample information that ends up not being used.

Creating Sample Info Files

Sample information must be entered into a tab-delimited text file using an application 
such as Microsoft® Office Excel® (saved as a .txt file) or Microsoft® Notepad.

If you decide not to create Sample Info files, the sample name only will be appear 
automatically in the Sample Info table. Gender, population and species will be 
designated as Unknown (Figure 3.1).

Guidelines to follow when creating Sample Info files are listed below.

• Use the column headings and format shown in Figure 3.2.

• Samples names:

- Maximum length is 50 characters

- Can appear only once in a Sample Info file

- Cannot contain the following characters: \ / : ; * ? " < > | ' , { } [ ]

Figure 3.1
Sample Info Icon and Table



chapter 3  |  Running the Protocol 27
Adding To or Updating Sample Info Files

You can add to and update information that has already been imported from Sample 
Info Files.

To add to and update Sample Info File information:

1. Edit the sample info text file.

2. In the left pane of GTGS, open the menu and select Samples.

3. Right-click the Sample Info icon and select Add/Update Sample Info.

4. In the Add/Update Sample Info window, click the Browse button.

5. Locate and select the Sample Info filename.

6. Select one or both check boxes to Add New Sample Info or Update Existing 
Sample Info.

7. Click Import.

8. Click Save.

Figure 3.2
Example of Sample Info Files
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Removing Unused Sample Info

You can remove information that was imported from Sample Info Files but was not 
used in your study.

To remove unused sample info:

1. In the left pane of GTGS, open the menu and select Samples.

2. Right-click the Sample Info icon and select Remove Unused Sample Info.

3. Click Yes when prompted to confirm this action.

Figure 3.3
Add/Update Sample Info Window
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ABOUT SAMPLE PLATE FILES

The layout of each sample plate used in the MIP Assay Protocol must be imported into 
GTGS prior to sample processing. The information in these files is used to design 
Anneal Plate layouts for the first stage of the protocol.

Sample plate information can be updated until the barcode of an Anneal Plate 
containing a sample from a particular plate is scanned.

Creating Sample Plate Files

The layout of each sample plate must be entered into a tab-delimited text file using 
an application such as Microsoft Office Excel (saved as a .txt file) or Notepad. 

• Use the column headings and format shown in Figure 3.4 on page 30. Sample types 
can be sample, control and water.

• Each text file should correspond to one sample plate only.

• Well designations must be based on a 96-well plate format (A1 through H12.)

• The sample plate does not need to be full. Do not include empty wells in the file.

• Samples name guidelines:

- Must be unique for each unique DNA (repeats should have the same name)

- Maximum length is 50 characters

- Cannot contain the following characters: \ / : ; * ? " < > | ' , { } [ ]

Updating Sample Plate Information

Sample plate information, except for the sample name, can be updated at any time.

To update sample plate information:

1. Edit the sample plate text file.

2. In the left pane of GTGS, open the menu and select Samples.

3. Expand the Sample Plates icon.

4. Right-click a sample plate and select Update Sample Plate …

5. In the Update Sample Plate window, click the Browse button.

6. Locate and select the sample plate filename.

7. Select External or Internal Samples as appropriate.

8. Click Import.

Assign a unique name to each unique DNA. Repeated samples of the same DNA
should have the same name. GTGS compares samples based on sample name. If
different DNA samples are assigned the same name, and if those samples are
analyzed together, the repeatability metrics calculated by GTGS will be incorrect.

For text files containing control DNA information, we recommend including the lot
number in the filename. For example, SMP2_wo0260_KitControl.txt. You can use
this filename as a the sample plate barcode later in the protocol.
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9. Click Save.

Control DNA Recommendations

To ensure the highest quality data, we strongly recommend running one positive 
control for every 23 samples. Control DNA is included in each GeneChip SNP Kit.

Figure 3.4
Example of Text Files with Sample Plate Layout and Control DNA Information

Microsoft Excel files with 
sample plate layout and 
control information. 
These files must be saved 
as tab-delimited text files 
(.txt).
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CREATE A PROJECT

Import Assay Panel and Genotype Settings Files

You must import the file created for your assay panel before you can run the protocol. 
The file is located on the CD-ROM that was shipped with the first GeneChip SNP 
Kits you received.

At the same time, we strongly recommend importing the genotype settings file that 
is located on the same CD-ROM. Even though the information in this file will not be 
used until data analysis, the software will not prompt you to load it. The settings in 
this file were optimized for your particular assay panel. If it is not present when 
performing data analysis, default genotype settings will be used and your results may 
not be optimal.

To import assay panel and genotype settings files:

1. In GTGS, import the assay panel and genotype settings files as follows:

A. Load the CD-ROM containing the files into the hard drive.

B. Open the drop-down menu and select Assay Panels.

C. Open File → Import Assay Panel (or right-click the Assay Panels folder)

D. In the Import Assay Panel window, click the Browse button next to the Assay 
Panel File field.

E. Locate and select the assay panel filename, then click Open.

F. Click the Browse button next to the Genotyping Settings File field.

G. Locate and select the genotype settings filename, then click Open.

H. Click the Import button.

Notice that the table in the Import Assay Panel window is now populated 
(Figure 3.6).

Figure 3.5
Selecting Assay Panels from the Menu
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I. Optional: Enter a description in the Description field.

J. Click Save.

If you expand the Assay Panel icon in the left pane, the type of GeneChip® Universal 
Tag Array that must be used with your assay panel is displayed. In the right pane, a 
list of the features present on the array is displayed.

Figure 3.6
Importing the Assay Panel and Genotype Settings Files

Figure 3.7
Displaying the Type of Array to be Used with a Particular Assay Panel
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Import Sample Information

You will now import your sample info files (optional) and sample plate files (required).

To import sample information:

1. Open the drop-down menu and select Samples.

2. Optional: Import Sample Info files as follows:

A. Right-click the Sample Info icon and select Add/Update Sample Info.

B. In the Add/Update Sample Info window, click the Browse button next to the 
Sample Info File field (Figure 3.9).

C. Locate and select the Sample Info filename, then click Open.

D. Select the Add New Sample Info check box.

E. Click the Import button.

Notice that the Sample Info Preview table is now populated.

F. Repeat this procedure for all Sample Info files you want to import.

G. Click Save.

Figure 3.8
Importing Sample Info Files

Figure 3.9
Add/Update Sample Info Window
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3. Import Sample Plate files as follows:

A. Right-click the Sample Plates icon and select Import Sample Plate (Figure 
3.10).

B. In the Import Sample Plate window (Figure 3.11), click the Browse button.

C. Locate and select a sample plate filename, then click Open.

D. Select Internal or External Samples as appropriate.

E. Click Import.

Notice that information about the sample plate is now displayed in the Import 
Sample Plate table (Figure 3.11). The software automatically designates the 
sample plate filename as the barcode. 

F. To change the barcode, either scan the sample plate barcode or type a new 
barcode into the Barcode field.

G. Click Save.

4. Repeat this procedure for each sample plate you want to add.

Figure 3.10
Importing Sample Plates

Figure 3.11
Import Sample Plate Window
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About Sample Plate Information

Expand the Sample Plates folder in the left pane to see a list of the sample plates you 
have imported. Select a sample plate name to see information specific to a particular 
plate.

In the right pane, you can view:

• General information about each sample plate such as the date it was imported 
(Sample Plates tab; Figure 3.12). 

• A list of samples on a particular plate by selecting the plate name, then clicking the 
Sample Plate Wells tab (Figure 3.13).

• The Sample Info associated with a particular sample plate by selecting the name of 
the sample plate and clicking the Sample Info tab (Figure 3.14).

You can fail a sample plate and add a description for a sample plate by modifying the 
sample plate properties. See Modifying Sample Plate Properties on page 36.

.

Figure 3.12
Sample Plate Information 

Figure 3.13
Sample Plate Wells Tab
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Modifying Sample Plate Properties

You can add a description for a sample plate or fail the entire sample plate by 
modifying the sample plate properties.

To modify sample plate properties:

1. Select a sample plate, then open Edit → Properties (or right-click the sample 
plate name).

2. Do one of the following:

A. Add or modify a description in the Description field (Figure 3.15).

B. Select or deselect the Failed check box.

3. Click Save.

Figure 3.14
Sample Info Tab

Figure 3.15
Modifying Sample Plate Properties
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CREATE A NEW PROJECT

1. Open the drop-down menu and select Projects.

2. Right-click the Projects folder and select New Assay Project.

3. In the Select an Assay Panel window (Figure 3.16), select the name of an assay 
panel, then click OK.

4. In the Project window (Figure 3.17):

A. Enter a project name in the Name field.

Project name constraints are:
- Maximum length is 50 characters
- Cannot contain the following characters: \ / : ; * ? “ < > | ' , {} [ ]

B. Accept the default values for Scanner Type (GeneChip_Scanner_3000) and 
Color Format (Four_Color).

C. Optional: In the Description field, enter a description for the project.

D. Click Save.

Figure 3.16
Select an Assay Panel Window

Projects are displayed alphabetically by name. Keep this in mind if you want your
projects displayed in a particular order.

Figure 3.17
Project Window
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In the left pane, click the + icons next to the project and Tracking icons to expand 
them (Figure 3.18). Notice the placeholders that have been created under the Tracking 
icon (Sample Plates, Anneal Plates, Assay Plates, Label Plates, Hyb Plates, and 
Arrays). Placeholders for array data information and genotype results are also created.

ADD SAMPLE PLATES TO A PROJECT

To add sample plates to a project, you will:

• Import a Sample Plate file (see About Sample Info Files on page 25 for more 
information)

• Scan the barcode of the sample plate

• Add the sample plate to your project

Add Sample Plates to Your Project

To add sample plates to your project:

1. Expand your project icon, then expand the Tracking icon (Figure 3.19).

2. Right-click the Sample Plates folder, and select Add Existing Sample Plate.

Figure 3.18
Structure of a Project
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3. Select a sample plate, then click OK (Figure 3.20).

4. Repeat this procedure to add more sample plates to your project.

To view the sample plates added to your project, expand the Sample Plates icon. 
Sample plate information is also displayed in the right pane of the window.

Figure 3.19
Adding Sample Plates to a Project

Figure 3.20
Selecting a Sample Plate

Project icon

Tracking icon
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Stage 1 – Design an Anneal Plate
Information describing the samples and their well locations on each sample plate is 
used to design the Anneal Plate. This information is imported into GTGS from tab-
delimited text files. If the sample information you require is not yet in GTGS, import 
it now. Refer to the appropriate sections under Create a Project starting on page 25 to 
create sample files and import them into your project.

For Stage 1, sample plate information is used to design an Anneal Plate. You will 
designate:

• Which samples are to be transferred from a sample plate to an Anneal Plate.

• Where the samples are to be located on the Anneal Plate.

HOW TO DESIGN AN ANNEAL PLATE

To design an Anneal Plate:

1. Right-click the Anneal Plates icon for your project and select Add Anneal Plate.

2. In the Define Sample Plate to Anneal Plate Mapping window, open the Source 
menu and select a sample plate (Figure 3.21).

3. Specify which samples are to be transferred from the Sample Plate to the Anneal 
Plate as follows:

A. Click and drag your cursor over one or more wells on the Sample Plate.

B. Click and drag your cursor over the Anneal Plate wells that you want the 
samples loaded in. (Shown in Figure 3.23 on page 41.)

C. Click Set.

Notice that the transfers you designate are displayed at the bottom of the 
window in the Transfers table (Figure 3.22).

4. When finished, click Save.

5. To edit the layout after you have clicked Save:

A. Expand the Anneal Plates icon.

B. Right-click the name of the Anneal Plate and select Edit Sample Mapping.

C. Select a line in the Transfers table; then click Clear (Figure 3.22).

D. Make your changes.

E. Click Save.

Figure 3.21
Selecting a Sample Plate for Anneal Plate Design
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Transfers with the status Ready can be changed. Transfers with the status
Complete cannot be changed.

Figure 3.22
Making Changes to Sample Mapping

Figure 3.23
Example of Sample to Anneal Plate Mapping

To modify transfers, select the appropriate line in the Transfers table and click Clear.
Transfers with the status Ready can be changed. Transfers with the status Complete cannot be changed

In this example, DNA from sample plate SMP2_0000601, well A1 to A11, B1 to B12, C1 to C11, and D1 to D12 is 
to be loaded into Anneal Plate wells A1 to A11, B1 to B12, C1 to C11 and D1 to D12. Kit Control DNA from the 
tube named SMP2_wo0260_KitControl is to be loaded into Anneal Plate wells A12 and C12. 
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VIEWING ANNEAL PLATE INFORMATION

To view the Anneal Plates you have designed, expand the Anneal Plates icon. To view 
information about a particular Anneal Plate, select the Anneal Plate name. In the right 
pane, select the appropriate tab to view:

• Properties – lists properties for an Anneal Plate such as who created it, the date it 
was created and the barcode.

• Incoming transfers – indicates which samples are to be loaded onto the Anneal Plate 
from a particular sample plate. Information includes the sample plate well and the 
Anneal Plate well.

• Outgoing transfers – indicates which Anneal Plate reactions are to be transferred to 
a specific Assay Plate and where they are to be placed (well location) on the Assay 
Plate. This table will remain empty until you have run the Anneal Plate and created 
an Assay Plate.

• All experiments – provides information that is available after the array barcodes are 
scanned. This information includes the date each sample was hybridized onto an 
array, as well as the barcode and well for each plate the sample was on during the 
protocol.
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Stage 2 – Anneal

ABOUT THIS STAGE

During this stage, the assay panel probes are annealed to genomic DNA target 
samples.

Genomic DNA samples, the assay panel probes, and reagents (Anneal Cocktail) are 
mixed in an Anneal Plate. An Anneal Plate is a 96-well PCR plate with the barcode 
designation ANN<barcode>. The plate is then placed on a thermal cycler and the 
program, Meg Anneal, is run. Because the samples must be left to anneal for ≥ 16 hours, 
this stage is typically started at the end of the day, and the anneal program is allowed 
to run overnight.

Figure 3.24
Assay Panel Probe

Figure 3.25
Assay Panel Probe Annealed to Genomic DNA Sample
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LOCATION AND DURATION

• Pre-Amp Lab

• Hands-on time: approximately 45 minutes

SAMPLE CONCENTRATION REQUIREMENT

Before starting this procedure, all samples should be normalized to a single 
concentration of 150 ng/μL using 1X TE buffer.

The Kit Control DNA included in every GeneChip SNP Kit has already been 
normalized to a working concentration. No further dilution or concentration is 
required. For more information, see Normalize Samples on page 22.

EQUIPMENT AND MATERIALS REQUIRED

The following equipment and materials are required to perform this stage. Quantities 
shown are for processing 48 reactions.

Table 3.1
Equipment and Materials Required for Stage 2 - Anneal

Quantity Item

1 Centrifuge, plate

1 Cube rack

1 Eppendorf tube, 2 mL

1 Ice container, rectangular, filled with ice

1 Marking pen, extra fine point, permanent

3 MicroAmp Clear Adhesive Films

1 Microfuge

1 PCR plate, 96-well, with ANN barcode

2 – 3 Plate holders (preparation racks)

1 Reagent reservoir, 50 mL

48 Samples of genomic DNA in barcoded plates

1 Thermal cycler, 96-well GeneAmp PCR System 9700 

1 Vortexer
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KIT COMPONENTS REQUIRED

Two GeneChip SNP Kits are required to anneal 48 reactions (including controls). The 
following components are required from each kit:

• Water (P/N 5-0004)

• Assay Panel
For Special Edition panels, there will be two assay panel tubes in the kit: 

- Standard Assay Panel tube (fill size 160 μL)

- Supplemental Assay Panel tube (fill size 60 μL)

• Buffer A

• Enzyme A

• Kit Control DNA

THAW REAGENTS

To thaw reagents:

1. Place the Water from kit, all Assay Panel tubes, Buffer A, and Kit Control DNA 
in a cube rack.

2. Allow to warm to room temperature on the bench top.

3. Keep on ice until ready to use.

Leave Enzyme A at –20°C until ready to use.
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RUN AN ANNEAL PLATE

To run an Anneal Plate:

1. If a project has not been created, create one now.

Creating a project is typically done once at the beginning of a study. You must 
create at least one project before you can perform the protocol and track samples 
using GTGS. For instructions, see Create a Project on page 25. 

2. Using a permanent marking pen, label the ANN-barcoded PCR plate as shown in 
Figure 3.26.

Four full rows (48 reactions) from an Anneal Plate are required to fill two Assay 
Plates.

3. In GTGS, expand the Project, Tracking and Anneal Plates icons.

4. Do the following:

A. Right-click an Anneal Plate and select Run Anneal Plate.

If you are not sure which Anneal Plate to choose, select an Anneal Plate in the 
left pane. In the right pane, click the Incoming Transfers tab and view the 
information displayed.

B. In the Run Anneal Plate window, follow the prompts in the uppermost field 
and scan the barcode of the first sample plate listed (Figure 3.27).

C. Press Enter or click Next.

D. If more than one sample plate is being used, scan the remaining sample plate 
barcodes as prompted by the software.

For the tube of Kit Control DNA, manually enter the barcode you created 
earlier.

Figure 3.26
Anneal Plate Labeling and Sample Placement

S A M P L E S C = Control DNA. Use of 
control DNA is optional.

IMPORTANT To ensure the 
highest quality data, we 
strongly recommend running 
1 control for every 23 
samples.

Placement of samples 
shown in wells 1 through 11 
of rows A, and C, and wells 1 
through 12 of rows B and D.

C

X is a placeholder. Mark the Anneal Plate with a sample 
plate row designation that is meaningful to you.

C

X

X

X

X
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E. Scan the Anneal Plate barcode and press Enter or click Next.

F. Scan the protocol barcode and press Enter or click Next.

A list of available protocols is displayed in the upper part of the window.

G. In the Thermal Cycler field, type the number of the thermal cycler the plate 
will be annealed on and press Enter or click Next.

H. Click Save; then click Close.

Notice that the name of the Anneal Plate in the left pane is now the barcode that you 
scanned. In this example, it changed from Anneal Plate:4 to ANN_0000201. 
Information about the Anneal Plate is also now displayed in the right pane under the 
Properties tab (the Anneal Plate name must be selected to see this information; Figure 
3.28).

Figure 3.27
Run Anneal Plate Window – Scanning Sample Plate Barcodes

The specific sample plate barcode to be scanned is displayed in this 
field. When more than one sample plate is being used, you must scan 
the sample plates in the order prompted by the software. In this 
example, SMP2_0000601 had to be scanned first. After pressing Enter, 
the software prompts the user to scan the barcode of sample plate 
SMP2_wo0260_KitControl.

Status Ready = a transfer between 
a source plate and a destination 
(plate or array) has been assigned 
in the software. The transfer can 
now be physically performed in the 
lab. Transfers with the status 
Ready can be edited (deleted, for 
example).

Barcodes scanned 
or entered manually 
appear here.
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ALIQUOT SAMPLES FROM SAMPLE TO ANNEAL PLATES

To aliquot samples from a sample plate to an Anneal Plate:

1. Spin down the sample plates at 1000 rpm for 30 seconds.

2. Place the sample and Anneal Plates in plate holders.

3. Spin down the Kit Control DNA.

4. In GTGS, select the Anneal Plate and click the Incoming Transfers tab in the 
right pane.

Notice that the Status of each transfer has changed to Complete (Figure 3.29.) 
Once the barcode of the destination plate or array is scanned, the software assumes 
that the samples have been physically transferred from the source to the 
destination. You cannot edit transfers with a status of Complete.

5. Transfer samples from the designated sample plate wells (Source and Source 
Location) to the Anneal Plate (Current and Current Location.)

• For 3K and 5K assay panels, aliquot 13.4 μL of:
- Genomic DNA sample to wells 1 through 11 of rows A and C, and wells 

1 through 12 of rows B and D.
- Kit Control DNA to well 12 of rows A and C.

• For 10K and 20K assay panels, aliquot 26.7 μL
- Genomic DNA sample to wells 1 through 11 of rows A and C, and wells 

1 through 12 of rows B and D.
- Kit Control DNA to well 12 of rows A and C.

Figure 3.28
Anneal Plate Properties
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PREPARING SPECIAL EDITION ASSAY PANELS

If you are working with a Special Edition assay panel, then your GeneChip SNP Kits 
contain two tubes of assay panel mix: one tube containing the Standard Panel mix (fill 
size 160 μL), and one tube containing the Supplemental Panel mix (fill size 60 μL). 
Before proceeding to the next step, Prepare Anneal Cocktail , you must combine the 
contents of these tubes as directed below.

To prepare the Special Edition assay panel:

1. Combine the standard and supplemental assay panels as follows:

A. To a 1.5 mL Eppendorf tube, add the appropriate amount of standard assay 
panel as shown in Table 3.2.

B. Rinse the pipette tip by pipetting up and down 5 times.

C. Add the appropriate amount of supplemental assay panel as shown in Table 3.2.

D. Rinse the pipette tip by pipetting up and down 5 times.

2. Cap the tube and spin down.

3. Mix by vortexing.

4. Spin down again and place on ice until ready to use.

Figure 3.29
Sample Plate to Anneal Plate Transfers

In this example, sample from well C12 of Sample Plate SMP2_000060 is to 
be transferred to well B1 of Anneal Plate ANN_2222. Samples C1, 2, 3, 4, 5, 
6, 7, 8, 9, 10 and 11 are to be transferred to wells A1, 2, 3, 4, 5, 6, 7, 8, 9, 10 
and 11, and so on.

Kit Control DNA from the tube called SMP2_wo0260_KitControl is to be 
aliquoted to wells A12 and C12 of the Anneal Plate ANN_2222.

The assay panel to be used to prepare the Anneal Cocktail is also listed 
(5-0059 3K Training Assay Panel in this example.) The Anneal Cocktail is to 
be aliquoted to all wells being used on the Assay Plate.

Status Complete = the Anneal Plate barcode has been scanned and the 
samples have been transferred from the Sample to the Anneal Plate. 
Transfers with the Status Complete cannot be changed.
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PREPARE ANNEAL COCKTAIL

To prepare the Anneal Cocktail:

1. Label a 2 mL Eppendorf tube with the letters AC.

2. Vortex and spin down Buffer A and the Assay Panel.

If using a Special Edition assay panel, the contents of the Standard and 
Supplemental assay panel tubes should have already been combined. See Preparing 
Special Edition Assay Panels on page 49.

3. Place on ice until ready to use.

4. To the tube labeled AC, add and mix the reagents listed in Table 3.3 in the order 
shown.

5. Store the remaining Water at 4°C.

6. Using a P1000 single-channel pipette, mix the Anneal Cocktail by pipetting up 
and down 5 times.

7. Keep on ice until ready to use.

The combination of Standard and Supplemental assay panels is now referred
to as the Assay Panel.

Table 3.2
Preparing the Special Edition Assay Panel Mix

Tube 1 Reaction 24 Reactions
(20% extra)

48 Reactions
(20% extra)

Standard Assay Panel Tube
(fill size 160 µL)

3.75 µL 144 µL 288 µL

Supplemental Assay Panel Tube
(fill size 60 µL)

1.25 µL 48 µL 96 µL

Total 5 µL 192 µL 384 µL

Enzyme A is extremely temperature sensitive. Keep at –20°C until ready to use, and
add last to the cocktail. To avoid denaturing, keep the Anneal Cocktail on ice until
ready to use. Minimize warming by hand contact.

Thaw and spin down Enzyme A before adding to the cocktail.
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ALIQUOT ANNEAL COCKTAIL AND BEGIN INCUBATION

To aliquot the Anneal Cocktail and begin incubation:

1. Place the Anneal Plates on ice.

2. If using manual 24-channel pipettes, add the Anneal Cocktail as follows:

A. Place a 50 mL reagent reservoir on ice.

B. Pipette the Anneal Cocktail into the 50 mL reagent reservoir.

C. Aliquot the Anneal Cocktail as follows (Table 3.4):
- For 3K/5K assay panels: Use a 12-channel P200 to add 31.6 μL to each reaction
- For 10K/20K assay panels: Use a 12-channel P20 to add 18.3  μL to each 

reaction

D. Set a 24-channel P100 to 30 μL, and mix each sample by pipetting up and 
down 10 times.

3. If using electronic 24-channel pipettes, add the Anneal Cocktail as follows:

A. Aliquot the cocktail to two strips of 12 tubes each as follows:

- For 3K/5K assay panels: Use a single-channel P200 to aliquot 35 μL (70 μL) to 
each tube

- For 10K/20K assay panels: Use a single-channel P20 to aliquot 20 μL (40 μL) 
to each tube

B. Aliquot the cocktail to each reaction by dispensing/mixing 10 times for each 
reaction as follows (Table 3.4):
-  3K/5K assay panels: Use a P200 set to dispense/mix at 31.6 μL.
- 10K/20K assay panels: Use a P20 set to dispense/mix at 18.3  μL.

Table 3.3
Anneal Cocktail

Reagents 1 Reaction 2 Rows
(20% extra)

4 Rows
(20% extra)

Water (from kit)   (3K/5K blue; 10K/20K green) 21.6 µL
8.3 µL

622 µL
239 µL

1244 µL
478 µL

Buffer A 5.00 µL 144 µL 288 µL

Assay Panel 5.00 µL 144 µL 288 µL

Enzyme A (keep at -20°C until addition) 0.0625 µL 1.8 µL 3.6 µL

Total Volume Anneal Cocktail   
(3K/5K blue; 10K/20K green)

31.6 µL
18.3 µL

912 µL
529 µL

1824 µL
1058 µL
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.

4. Seal each plate with a MicroAmp adhesive film, covering all wells even if empty.

5. Spin down the Anneal Plate at 1000 rpm for 30 seconds.

6. Start the thermal cycler program, Meg Anneal (Figure 3.30).

7. When the temperature on the thermal cycler reaches 20°C, load the Anneal Plate 
and close the lid.

8. Incubate the samples for 16 to 24 hours.

Optimal incubation time is 16 to 24 hours. Do not incubate samples for more than 
30 hours.

PREPARE FOR STAGE 4

To prepare for stage 4:

Place three to four 96-well aluminum blocks in a -20°C freezer overnight.

Table 3.4
Genomic DNA, Kit Control DNA and Anneal Cocktail

Component 3K and 5K Assay 
Panels

10K and 20K Assay 
Panels

Genomic DNA (150 ng/µL) or Kit Control DNA 13.4 µL 26.7 µL

Anneal Cocktail 31.6 µL 18.3 µL

Total 45 µL 45 µL

Figure 3.30
Meg Anneal Thermal Cycler Program
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Stage 3 – Plan and Run Assay Plates

ABOUT THIS STAGE

During this stage, you will plan and prepare what are referred to as Assay Plates. An 
Assay Plate is a 96-well PCR plate with the barcode designation ASY<barcode>. You 
will use GTGS to perform this step.

LOCATION AND DURATION

• Pre-Amp Lab

• Hands-on time: approximately 10 minutes

EQUIPMENT AND MATERIALS REQUIRED

The following materials are required to perform this stage.

PLAN ASSAY PLATES

To plan Assay Plates:

1. Using a permanent marking pen, label the ASY-barcoded PCR plates as shown in 
Figure 3.31.

One Assay Plate can hold up to two full rows of samples from an Anneal Plate. 
Samples are placed in rows A and E only of the Assay Plate.

Table 3.5

Quantity Item

1 Marking pen, extra fine point, permanent

2 PCR plate, 96-well, with ASY barcode

To ensure the highest quality data, we strongly recommend running one positive
control for every 23 samples. Control DNA is included in each GeneChip SNP Kit.
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2. In GTGS, expand the Project and Tracking icons.

3. Right-click the Assay Plates icon and select Add Assay/Label/Hyb Plate Trio.

4. Open the Source menu and select an Anneal Plate.

You cannot change the Destination (Assay Plate).

5. Select the samples to be transferred from the Anneal Plate to the Assay Plate using 
one of these methods:
• Highlight a row of samples on the Anneal Plate.
• Select an individual sample on the Anneal Plate, such as sample B3 only.
• Select a smaller group of samples, such as samples B1 through B4 only.

6. Do one of the following:
• If you selected an entire row, highlight row A or E on the Assay Plate, then click 

Set (see Figure 3.32.)
• If you selected one sample, highlight one well in row A or E on the Assay Plate, 

then click Set.
• If you selected a smaller group of samples, highlight the corresponding number 

of cells in row A or E on the Assay Plate, then click Set.

7. When all sample transfer designations are complete, click Save.

Figure 3.31
Assay Plate Labeling

Each Assay Plate can hold a total of 24 reactions (including controls). When
planning the Assay Plate in GTGS, the software restricts you to mapping samples
from the Anneal Plate to rows A and E only of the Assay Plate.
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X

Anneal Plate row 
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Expand the Assay, Label and Hyb Plates icons. Notice there is now a placeholder for 
each type of plate in these folders. These three plates are linked. As you move through 
the protocol, each one will automatically appear in the plate mapping Source or 
Destination field as appropriate. Assay Plate samples are transferred to Label Plates, 
and Label Plate samples are transferred to Hyb Plates.

Figure 3.32
Planning an Assay Plate

To delete an Assay/Label/Hyb plate trio, you must select and delete the Hyb Plate.
This action deletes the associated Assay and Label Plates as well. Once you begin
the next stage of the protocol and scan an Assay Plate barcode, you can no longer
delete these plates.

Row A on Anneal 
Plate designated for 
transfer to Row A of
Assay Plate.

Row B on Anneal 
Plate designated for 
transfer to Row E of 
Assay Plate.

After clicking Set, 
sample indicators 
change to color 
code for Pending.
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RUN ASSAY PLATES

To run Assay Plates:

1. Expand the Assay Plates icon.

2. Right-click an Assay Plate and select Run Assay Plate.

3. Scan the Anneal Plate barcode (appears in the Source field) and press Enter.

4. Scan the Assay Plate barcode (appears in the Source field) and press Enter.

5. Press Enter again to proceed past the protocol barcode which is already displayed 
in the Protocol field.

6. Enter a thermal cycler number and press Enter.

7. Click Save; then click Close.

Notice that information about the Assay Plate is now displayed in the right pane 
under each of the tabs (Figure 3.33).

Figure 3.33
Assay Plate Tabs

Properties tab for the Assay Plate.

Incoming Transfers tab

Outgoing Transfers tab

Well Status tab
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Stage 4 – Gap Fill, dNTP, Ligate, Invert, First PCR

ABOUT THIS STAGE

During this stage, samples are transferred from the Anneal Plate to two Assay Plates. 
During the transfer, samples are split into four equal aliquots. Several additions are 
then made to each sample, one addition at a time, at specific intervals. The additions 
designated as cold are made on ice; the additions designated as hot are made while the 
samples are on a thermal cycler.

The thermal cycler program run for these additions is determined by the size of the 
assay panel you are using. It will be one of the following: the Meg 3K 5K 10K program, 
or the Meg 20K program.

Gap Fill Mix Addition

The first addition, Gap Fill Mix, is a cold addition. Gap fill enzymes find and bind to 
the single base gap in the assay panel probe. The gap is centered where the SNP of 
interest is located in the genome.

dNTP Addition & Ligation

Each sample is now split into 4 equal aliquots in the Assay Plate, followed by the 
addition of dNTPs. For this cold addition, a different nucleotide is added to each 
aliquot. In the example shown in Figure 3.35, only the aliquot containing dATP will 
undergo a reaction, wherein the gap fill enzymes will use dATP to fill the gap in the 
probe.

Once the gap in the probe is filled, the backbone of the assay probe is covalently sealed. 
The sealed probe is now referred to as a padlocked probe.

Figure 3.34
Gap Fill Enzyme Addition

This example is based on a homozygous SNP locus. If the sample was
heterozygous for this locus, two of the four aliquots would have a nucleotide added
to the probe.

Gap Fill Enzyme
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Exo Mix Addition

The third addition is the Exo Mix, a cold addition. In this step, exonucleases are added 
to each aliquot. The exonucleases digest the linear probes and single-stranded DNAs 
that are present (Figure 3.36). Linear probes are present in the aliquots where the gap 
was not filled by a dNTP. Single-stranded DNA is present in all aliquots.

Figure 3.35 
dNTP Addition
This example depicts one assay probe only. In reality, thousands of probes are undergoing the 
same process simultaneously.

Figure 3.36
Exo Mix Addition Showing Two Aliquots Only

Only the probe in the A 
aliquot has a 
nucleotide added to it.

The gap in the G, C and 
T aliquots is never 
filled; these probes 
remain linear.
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For homozygotes:

After the Exo Mix addition, three of the four aliquots contain digested DNA only 
for each assay probe. In the fourth aliquot, the genomic DNA is mainly digested 
away except for the small region where it is double-stranded due to its association 
with the padlocked probe.

For heterozygotes:

After the Exo Mix addition, two of the four aliquots contain digested DNA only. 
In the other two aliquots, the genomic DNA is mainly digested away except for 
the small region where it is double-stranded due to its association with the 
padlocked probe.

Cleavage Mix Addition and Inversion

The fourth addition is the Cleavage Mix, a hot addition. The padlocked probe is 
cleaved at cleavage site 1 in the assay probe backbone, thereby releasing it from the 
genomic DNA.

Once the assay probe has been cleaved, it releases from the remaining genomic DNA 
and becomes a linear molecule. Because the orientation of the PCR primer sequences 
has changed from the original orientation, the probe is now referred to as an inverted 
probe.

Figure 3.37
Cleavage Mix Addition

Figure 3.38
Inverted Probe

Cleavage site 1

After cleavage and release from the genomic DNA, the probe inverts.
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Amp Mix Addition and First PCR

The fifth addition is the Amp Mix, a hot addition. Once the Amp Mix is added, a PCR 
reaction takes place and the probe is amplified using common primers. The product 
from this reaction is referred to as the first PCR product (Figure 3.39).

LOCATION AND DURATION

• Pre-Amp Lab

• Hands-on time: 2.5 hours

EQUIPMENT AND MATERIALS REQUIRED

The following equipment and materials are required to perform these stages. 
Quantities shown are for processing 48 reactions.

Figure 3.39
Amplified Probes from First PCR

Table 3.6
Equipment and Materials Required for Stage 4 – Gap Fill, dNTP, Ligate, Invert, First PCR

Quantity Item

3 or 4 Aluminum blocks, chilled (or 2 aluminum blocks and 1 to 2 plate holders)

1 Anneal Plate from previous stage

2 Assay Plates, prepared and scanned

1 Centrifuge, plate

1 Ice container, rectangular, filled with ice

12 MicroAmp Clear Adhesive Films

1 Microfuge

2 Reagent reservoirs, 50 mL

2 Thermal cyclers, 96-well GeneAmp PCR System 9700 

4 Tube strips with caps, PCR 12-well
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KIT COMPONENTS REQUIRED

The following components are required from each GeneChip SNP Kit:

• Gap Fill Mix

• Exo Mix

• Cleavage Enzyme

• Cleavage Tube

• Amp Mix

• Plate of dNTPs (located in compartment below reagent tubes in the Pre-Amp Lab 
box)

OTHER REAGENTS REQUIRED

Stratagene Taq Polymerase (P/N 929197), 134 μL.

For more information, refer to Taq Polymerase Required on page 7.

THAW THE REAGENTS

To thaw the reagents:

1. Thaw the plate of dNTPs, the Cleavage Tube, and Amp Mix on the bench top.

2. Keep on ice until ready to use.

PREPARE THE GAP FILL MIX, EXO MIX, AND DNTP PLATE

Prepare the Gap Fill Mix

To prepare the Gap Fill Mix:

1. Place a plate holder or a chilled aluminum block on ice.

2. Spin down the Gap Fill Mix (G).

3. Label two strips of 12 PCR tubes with the letter G.

4. Aliquot 5 μL (10 μL) of Gap Fill Mix to each tube.

5. Cap and spin down the strip tubes.

6. Place the tubes in a plate holder or chilled aluminum block in adjacent rows.

7. Keep on ice until ready to use.

Leave the Exo Mix, Gap Fill Mix, Cleavage Enzyme, and Taq Polymerase at -20°C
until ready to use.

Volumes shown are for 24 reactions (and 48 reactions) respectively.
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Prepare the Exo Mix

To prepare the Exo Mix:

1. Spin down the Exo Mix (E).

2. Label two strips of 12 PCR tubes with the letter E.

3. Aliquot 21 μL (42 μL) of Exo Mix to each tube.

4. Cap and spin down the strip tubes.

5. Place the tubes in the same plate holder or chilled aluminum block as the Gap Fill 
Mix.

Prepare the dNTP Plate

To prepare the dNTP Plate:

1. Spin down the plate of dNTPs.

2. Place on ice until ready to use.

ADD GAP FILL MIX – ADDITION #1 ON COLD BLOCK

To add the Gap Fill Mix:

1. Remove two aluminum blocks from the −20°C refrigerator and set on ice.

2. Stop the Meg Anneal thermal cycler program.

3. Remove the Anneal Plate from the thermal cycler.

4. Place the Anneal Plate in a chilled aluminum block on ice and cool for 2 min. 

5. Spin down the plate at 1000 rpm for 30 seconds.

6. Place an Assay Plate in an aluminum block on ice.

7. Slowly remove the clear film from the Anneal Plate.

8. Working two rows at a time on the Anneal Plate (Figure 3.40), add the Gap Fill 
Mix using one of the following methods:

• If using manual 24-channel pipettes:

1) Use a P20 to add 2.5 μL of Gap Fill Mix to each sample.

2) Mix up and down 3 times to rinse all of the Gap Fill Mix from the pipette 
tip.

3) Set a P200 to 20 μL and mix each sample up and down 10 times.

Be sure to keep the two mixes separated and easily identifiable. These mixes are
added to the samples at different times. The Gap Fill Mix is added first.

To save time, you can prepare the Exo Mix during the first or second 58°C
incubation.

These instructions are based on working with 48 reactions.
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• If using electronic 24-channel pipettes:

1) Set a P20 to dispense at 2.5 μL and mix at 19 μL.

2) Dispense/mix Gap Fill Mix to each sample 10 times.

TRANSFER AND SPLIT SAMPLES

You will now transfer one row of samples from the Anneal Plate to four rows of an 
Assay Plate, splitting each sample into four aliquots of equal size.

To transfer and split samples:

1. Using a 12-channel P10 pipette, transfer and split the samples from the first two 
rows of the Anneal Plate to an Assay Plate as follows (Figure 3.41):

A. Transfer 9 μL from each well of the first row (A1 to A12 in the example) of the 
Anneal Plate to the rows marked A, C, G and T on the top half of the Assay 
Plate (A1 to D12.)

B. Transfer 9 μL from each well of the next row (B1 to B12 in the example) of the 
Anneal Plate to the rows marked A, C, G and T on the bottom half of the Assay 
Plate (E1 to H12.)

Figure 3.40
Cold Addition

Anneal Plate in 
aluminum block on ice

24-channel pipette
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2. Seal all of the wells of the Assay Plate with clear adhesive film.

3. Spin down the Assay Plate at 1000 rpm for 30 seconds.

4. Place in an aluminum block on ice.

5. Start the appropriate thermal cycler program:
• For 3K/5K/10K assay panels: Meg 3-5-10K
• For 20K assay panels: Meg 20K

See Figure 3.42 on page 65.

6. When the thermal cycler reaches 58°C, load the Assay Plate and close the lid.

7. For 48 reactions, repeat the transfer and split process for the remaining two rows 
of samples on the Anneal Plate to the second Assay Plate plate.

8. Leave the aluminum blocks on ice.

Figure 3.41
Transferring Samples from the Anneal Plate to the Assay Plates

The placement of each Assay Plate onto a thermal cycler should be staggered by
approximately 2 minutes.

S A M P L E S

Samples from row A of the Anneal Plate are transferred and split between rows A, B, C and D (marked A, C, G and T) of 
the first Assay Plate. Samples from row B of the Anneal Plate are transferred and split between rows E, F, G and H of the 
first Assay Plate. C = Kit Control DNA.
NOTE: The samples in rows C and D are transferred to the second Assay Plate and are split in the same manner.
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ADD DNTPS – ADDITION #2 ON COLD BLOCK

To add the dNTPs: 

1. When the thermal cycler timer reads 1:00 minute remaining for the second 58°C 
period (Figure 3.42), press Pause.

2. Remove the Assay Plate and place it in an aluminum block on ice for 2 minutes.

3. Remove the seal from the Assay Plate and the dNTP plate.

4. If using a manual 24-channel P20 pipette, add dNTPs to each reaction as follows 
(Figure 3.43):

A. Aliquot 4.0 μL dATP to row A, and 4.0 μL dCTP to row B.

B. Mix by pipetting up and down 20 times, reaching the bottom of all wells.

C. Aliquot 4.0 μL dGTP to row C, and 4.0 μL dTTP to row D.

D. Mix by pipetting up and down 20 times, reaching the bottom of all wells.

5. If using an electronic 24-channel P20 pipette, add dNTPs to each reaction as 
follows (Figure 3.43):

A. Set the pipette to dispense and mix at 4 μL.

B. Dispense/mix dNTPs to each sample 20 times.

6. Repeat these additions for the bottom half of the plate.

Figure 3.42
Meg 3-5-10K and Meg 20K Thermal Cycler Programs

Per

Perform this procedure one Assay Plate at a time.

PHYSICAL INJURY HAZARD. The thermal cycler lid, sample block and Assay Plate
are very hot. Wear protective gloves when opening and closing the lid, and when
handling Assay Plates.
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7. Reseal the plate with a new adhesive film.

8. Spin down at 1000 rpm for 30 seconds.

9. Place the plate back on the thermal cycler and close the lid.

10. Press Resume to continue the thermal cycler program.

11. Repeat this procedure for all remaining Assay Plates.

ADD EXO MIX – ADDITION #3 ON COLD BLOCK

To add the Exo Mix:

Perform this procedure one Assay Plate at a time.

1. When the timer reads 14:00 minutes remaining for the first 37°C period 
(Figure 3.42 on page 65):

A. Press Pause on the thermal cycler.

B. Remove the Assay Plate and place in an aluminum block on ice for 2 minutes.

C. If using a manual 24-channel P20 pipette:

1) Add 4 μL of Exo Mix to each reaction.

2) Mix by pipetting up and down 20 times, reaching the bottom of all wells.

D. If using an electronic 24-channel P20 pipette:

1) Set the pipette to dispense and mix at 4 μL

2) Add Exo Mix to each reaction, mixing each reaction 20 times.

2. Reseal the plate with a new adhesive film.

3. Spin down at 1000 rpm for 30 seconds.

4. Place the plate back on the thermal cycler and close the lid.

5. Press Resume to continue the thermal cycler program.

6. Repeat this procedure for all remaining Assay Plates.

Figure 3.43
dNTP Addition
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PREPARE THE CLEAVAGE AND AMP MIXES

Prepare the Cleavage Mix

To prepare the Cleavage Mix:

1. Spin down the Cleavage Enzyme.

2. Using a P200 single channel pipette, add 24 μL of Cleavage Enzyme to each 
Cleavage Tube.

This mixture is now referred to as the Cleavage Mix.

3. Using a P1000 single channel pipette, mix well.

4. Mark a 50 mL reagent reservoir with the letter C.

5. Transfer the Cleavage Mix to the reagent reservoir marked C and place on ice.

Prepare the Amp Mix

To prepare the Amp Mix:

1. pin down the Stratagene Taq polymerase.

2. Using a P200 single channel pipette, add 67 μL of Taq polymerase to the Amp Mix 
tube.

3. Using a P1000 single channel pipette, mix well.

4. Mark a 50 mL reagent reservoir with the letter A.

5. Transfer the Amp Mix to the reagent reservoir marked A and place on ice.

Prepare during first 95°C hold.

Prepare during first 95°C hold.
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ADD CLEAVAGE MIX – ADDITION #4 ON THERMAL CYCLER

To add the Cleavage Mix:

1. When the thermal cycler timer reads 9:00 minutes remaining for the second 37°C 
period (Figure 3.42 on page 65):

A. Press Pause on the thermal cycler and open the lid.

B. Leaving the Assay Plate on the cycler, remove the adhesive film.

C. Using a 12-channel P200 pipette, aliquot 25 μL of Cleavage Mix to each 
reaction.

D. Mix by pipetting up and down 10 times (Figure 3.44).

E. Reseal the plate with a new adhesive film, and close the thermal cycler lid.

F. Press Resume to continue the thermal cycler program.

2. Repeat this procedure for all remaining Assay Plates.

Perform this addition one Assay Plate at a time.

Figure 3.44
Hot Addition on Thermal Cycler



chapter 3  |  Running the Protocol 69
ADD AMP MIX – ADDITION #5 ON THERMAL CYCLER

To add the Amp Mix:

1. When the thermal cycler temperature reaches 60°C (Figure 3.42 on page 65):

A. Press Pause on the thermal cycler and open the lid.

B. Leaving the Assay Plate on the cycler, remove the adhesive film.

C. Using a 12-channel P200 pipette, aliquot 25 μL of Amp Mix to each reaction.

D. Mix by pipetting up and down 10 times.

E. Reseal the plate with a new adhesive film.

F. Close the thermal cycler lid.

G. Press Resume to continue the thermal cycler program.

2. Repeat this procedure for all remaining Assay Plates.

TRANSFER ASSAY PLATES AND KIT COMPONENTS TO POST-AMP LAB

To transfer the Assay Plates and remaining GeneChip SNP Kit components:

1. At the end of the program (approximately one hour after the start of the first PCR 
amplification), remove the Assay Plates from the thermal cyclers.

2. Leaving the plates sealed, transfer the plates and the remaining GeneChip SNP Kit 
contents to the Post-Amp Lab.

3. Store the kit contents in the appropriate refrigerator or freezer.

4. If not immediately proceeding to Stage 5 – Second PCR, the Assay Plates can be 
stored at -20°C.

Perform this addition one Assay Plate at a time.

CONTAMINATION DANGER. Do not remove the adhesive film from the Assay
Plates. Assay Plates must remain sealed until they have been transferred to the
Post-Amp Lab.

We recommend freezing and thawing plates ONE TIME ONLY. For a given set of
samples, do not freeze and thaw plates multiple times during the protocol.
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Stage 5 – Second PCR

ABOUT THIS STAGE

During this stage, you will prepare what are referred to as Label Plates (96-well PCR 
plates with the barcode designation LBL<barcode>.) Each sample is transferred from 
the Assay Plate to a Label Plate.

After the transfer, a different allele-specific primer is added to each reaction as a label, 
and the second PCR is performed. The thermal cycler program used is determined by 
the size of the assay panel. For 3K and 5K assay panels, Meg Hypcr 3-5K is used. For 
10K and 20K assay panels, Meg Hypcr 10-20K is used.

LOCATION AND DURATION

• Post-Amp Lab

• Hands-on time: Approximately 25 minutes

• Thermal cycler time: 30 minutes

Figure 3.45
Second PCR

Second PCR product with 
allele-specific labeling

First PCR product
Tag Amplified DNA
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EQUIPMENT AND MATERIALS REQUIRED

The following equipment and materials are required to perform this stage. Quantities 
shown are for processing 48 reactions.

KIT COMPONENTS REQUIRED 

The following components are required from each GeneChip SNP Kit:

• HY A Allele Tube

• HY C Allele Tube

• HY G Allele Tube

• HY T Allele Tube

OTHER REAGENTS REQUIRED

Clontech TITANIUM Taq DNA Polymerase

For more information, refer to Taq Polymerase Required on page 7.

THAW REAGENTS

To thaw reagents:

1. Thaw the HY A Allele, HY C Allele, HY G Allele, and HY T Allele tubes on the 
bench top.

2. Spin down each tube.

3. Keep on ice until ready to use.

Table 3.7
Equipment and Materials Required for Stage 5 – Second PCR 

Quantity Item

2 Assay Plates with samples from previous stage

1 Centrifuge, plate

1 Ice container, rectangular, filled with ice

2 PCR plates, 96-well, with LBL barcode

2 Marking pens, extra fine point, permanent, different colors

minimum 4 MicroAmp Clear Adhesive Films

1 Microfuge

4 Plate holders (preparation racks)

4 Reagent reservoirs, 50 mL

2 Thermal cyclers 
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RUN LABEL PLATES

To run Label Plates:

1. Using a permanent marking pen, mark the LBL barcoded plates as shown in
Figure 3.46.

2. In GTGS, expand the Project, Tracking and Label Plate icons.

3. Right-click the appropriate Label Plate.

If you are not sure which Label Plate is correct, select a Label Plate. In the right-
hand pane, look at the Assay Plate indicated in the Source column under the 
Incoming Transfers tab.

4. Select Run Label Plate.

The Run Label Plate window appears (Figure 3.47).

H. Scan the Assay Plate barcode (Source Plate field) and press Enter.

Figure 3.46
Label Plate Labeling and Sample Placement

Figure 3.47
Run Label Plate Window
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I. Scan the Label Plate barcode (Label Plate field) and press Enter.

J. Press Enter again to proceed past the protocol barcode which is already 
displayed in the Protocol field.

K. Enter a thermal cycler number and press Enter.

L. Click Next; then click Save.

5. Using a marking pen, mark the Assay and Label Plates with the same color. 

Use a different color for each set of plates to ensure that samples are transferred 
from each Assay Plate to the correct Label Plate.

6. Repeat these steps for the next Label Plate.

PREPARE HY ALLELE TUBE MIXES

To prepare the Allele Tube Mixes:

1. Spin down the TITANIUM Taq polymerase.

2. Using a P100 pipette, add 22 μL of Taq polymerase to each allele tube.

3. Set a P1000 pipette to 750 μL and mix by pipetting up and down 10 times. 

4. Label one set of 12 strip tubes for each HY Allele mix: A, C, G and T

5. Aliquot 75 μL (150 μL) of each allele tube mix as follows:

• HY A Allele Tube Mix to the strip tubes labeled A.

• HY C Allele Tube Mix to the strip tubes labeled C.

• HY G Allele Tube Mix to the strip tubes labeled G.

• HY T Allele Tube Mix to the strip tubes labeled T.

TRANSFER REACTIONS TO LABEL PLATES AND ADD ALLELE TUBE MIXES

To transfer reactions to Label Plates and add Allele Tube mixes:

1. Working one row at a time using a 12-channel P200 pipette, aliquot 31 μL of each 
Allele Tube mix to the corresponding row on the Label Plate (Figure 3.44):
• HY A Allele Tube mix to rows labeled A (A and E)
• HY C Allele Tube mix to rows labeled C (B and F)
• HY G Allele Tube mix to rows labeled G (C and G)
• HY T Allele Tube mix to rows labeled T (D and H)

2. If using manual 24-channel pipettes:

A. Set a P20 to 4 μL and transfer 4 μL from each well of the top two rows of the 
Assay Plate (marked A and C) to the same rows on the Label Plate.

B. Mix by pipetting up and down 5 times.

C. Set a P100 to 20 μL, and mix by pipetting up and down 10 times.

D. Continue transferring and mixing the remaining reactions from the Assay Plate 
to the Label Plate in the same manner.
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3. If using electronic 24-channel pipettes:

A. Set a P20 to dispense/mix at 4 μL. 

B. Dispense/mix 4 μL from each well of the top two rows of the Assay Plate 
(marked A and C) to the same rows on the Label Plate 5 times.

C. Set a P100 set to dispense/mix at 20 μL. Mix each reaction by dispensing/
mixing 10 times.

D. Continue transferring and mixing the remaining reactions from the Assay Plate 
to the Label Plate in the same manner.

4. Seal each Label Plate with a new adhesive film.

5. Spin down the Label Plates at 1000 rpm for 30 seconds.

6. Place each Label Plate onto a thermal cycler and close the lid.

7. Start the appropriate thermal cycler program:

• For 3K/5K assay panels, use Meg Hypcr 3-5K

• For 10K/20K assay panels, use Meg Hypcr 10-20K (Figure 3.48).

8. If running a quality control gel, refer to First Quality Control Gel on page 75 now.

9. When the program is finished, remove the plates and spin down at 1000 rpm for 
30 seconds.

10. Proceed directly to Stage 6 – Target Digest on page 77.

This program takes approximately 30 minutes to run.

Figure 3.48
Meg Hypcr 3-5K and Meg Hypcr 10-20K Thermal Cycler Programs

Do not freeze samples at this stage of the protocol. Proceed directly to the next
stage.
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FIRST QUALITY CONTROL GEL

The first quality control gel is run while the second PCR thermal cycler program is 
running (Meg Hypcr 3-5K or Meg Hypcr 10-20K). Samples are taken from the Assay 
Plates. For gel recommendations, see Quality Control Gels on page 19.

To run the first quality control gel:

1. Pipette 7 μL of each sample from an Assay Plate to a 96-well PCR plate.

2. Add 3 μL loading buffer and mix well.

3. Load onto a gel.

4. Repeat steps 1 through 3 for each Assay Plate and gel.

5. Seal the Assay Plates with new adhesive films and store at -20°C.

6. Run and inspect the gels.

VIEWING THE FIRST QUALITY CONTROL GEL 

A good first quality control gel will look like the one shown below.

Figure 3.49
Good First Quality Control Gel for Assay Panel run on a 10K Universal Tag Array – Top Half Only

For this sample, differences in band intensity indicate that there is variation in the amount of product in each well. 

This amount of variation is typically acceptable. See 
Figure 3.50 for an example of unacceptable well variation.

A C

G T

More product can appear 
in the center wells than 
in the side wells.

Positive controls look 
identical in appearance 
and number of bands as 
compared to samples.
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Figure 3.50
First Quality Control Gel with Mixed Results

Unacceptable well variation. These samples 
failed when hybridized to arrays and 
scanned.
Failure was due to unacceptably low signal 
strength in several channels. Repeat the 
experiment from Stage 1.

Samples in wells 17 through 22 passed 
when hybridized to arrays and scanned. 
The variation in appearance of these 
bands is within acceptable limits.
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Stage 6 – Target Digest

ABOUT THIS STAGE

During this stage, the labeled second PCR product is cleaved at cleavage site 2 in the 
backbone. This process removes the amplified genomic DNA portion of the assay 
probe from the tag and allele-specific label.

As part of this stage, you will prepare what are referred to as Hyb Plates (96-well PCR 
plates with the barcode designation HYB<barcode>).

You will then transfer the four individual reactions for each sample from the Label 
Plate to a Hyb Plate. At the same time, you will consolidate the four reactions for each 
sample back to one well. The Hyb Plates are then placed on thermal cyclers and the 
Meg Hydigest-a program is run. 

LOCATION AND DURATION

• Post-Amp Lab

• Hands-on time: approximately 30 minutes

• Time on thermal cycler: 1 hour and 35 minutes

Figure 3.51
Target Digest

First PCR product
Tag Amplified DNA

Second PCR product – allele-
specific labeling

Cleave amplified DNA from probe at cleavage 
site 2 to release allele-specific products
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EQUIPMENT AND MATERIALS REQUIRED

The following equipment and materials are required to perform this stage. Quantities 
shown are for processing 48 reactions.

KIT COMPONENTS REQUIRED

The following component is required from each GeneChip SNP Kit:

• HY Digest Mix

RUN HYB PLATES

To run Hyb Plates:

1. Using a permanent marking pen, label the HYB-barcoded plates as shown in 
Figure 3.52 on page 79.

2. In GTGS, expand the project, Tracking and Hyb Plates icons. 

3. Right-click the appropriate Hyb Plate and select Run Hyb Plate.

To determine the correct Hyb Plate, select a Hyb Plate and click the Incoming 
Transfers tab. Look at the Label Plate specified in the Source field.

4. Scan the Label Plate barcode (Source Plate field) and press Enter.

5. Scan the Hyb Plate barcode (Hyb Plate field) and press Enter.

6. Press Enter again to proceed past the protocol barcode which is already displayed 
in the Protocol field.

Table 3.8

Quantity Item

1 Centrifuge, plate

1 Ice container, rectangular, filled with ice

2 Label Plates containing samples from previous stage

1 Marking pen, extra fine point, permanent

4 MicroAmp Clear Adhesive Films

1 Microfuge

2 PCR plates, 96-well, with HYB barcode

3 Plate holders (preparation racks)

2 Thermal cyclers 

2 Tube strip with caps, PCR 12-well

PHYSICAL INJURY HAZARD. The thermal cycler lid, sample block and PCR plate are
very hot. Wear protective gloves when opening and closing the lid, and when
handling the PCR plate.
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7. Enter a thermal cycler number and press Enter.

8. Click Save; then click Close.

TRANSFER REACTIONS TO HYB PLATES

While transferring reactions from Label to Hyb Plates, you will consolidate all four 
reactions for each sample into one well.

To transfer reactions to Hyb Plates:

1. Spin down each Label Plate at 1000 rpm for 30 sec.

2. Set a 12-channel P20 pipette to 17 μL.

3. Remove the seal from each Label Plate.

4. Transfer 17 μL from each well of Label Plate rows A, B, C and D to Hyb Plate 
row A (Figure 3.52).

5. Transfer 17 μL from each well of Label Plate rows E, F, G and H to Hyb Plate 
row B.

Total volume in each well should be 68 μL.

ADD HY DIGEST MIX

To add the HY Digest Mix:

1. Spin down the HY Digest Mix and keep on ice until ready to use.

2. Into two strips of 12 PCR tubes each, aliquot 9 μL (18 μL) of HY Digest Mix to 
each tube using a P20 single channel pipette.

3. Cap and spin down the strip tubes.

4. Place the tubes in a plate holder on ice (in 2 adjacent rows) until ready to use.

5. If using manual 24-channel pipettes:

Figure 3.52
Hyb Plate Labeling and Sample Placement

Volumes shown are for 24 reactions (and 48 reactions) respectively.

S A M P L E S
Rows A through D of the Label 
Plate are consolidated to row A of 
the Hyb Plate.
Rows E through H of the Label 
Plate are consolidated to row B of 
the Hyb Plate.

C
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A. Set a P20 to 6 μL.

B. Aliquot 6 μL of HY Digest Mix to each sample, and mix by pipetting up and 
down 5 times to ensure the tip is thoroughly rinsed.

C. Set a P100 to 50 μL, and mix each reaction by pipetting up and down 15 times.

6. If using electronic 24-channel pipettes:

A. Set a P20 to dispense/mix at 6 μL. 

B. Dispense/mix 6 μL of HY Digest Mix to each sample 5 times.

C. Set a P100 to dispense/mix at 50 μL.

D. Mix each sample by dispensing/mixing 15 times.

7. Seal each plate with a new adhesive film.

8. Spin down at 1000 rpm for 30 seconds.

RUN THE MEG HYDIGEST-A PROGRAM

To run the Meg Hydigest-a program:

1. Place each plate on a thermal cycler and close the lid.

2. Start the program, Meg Hydigest-a (Figure 3.53).

3. If running a second quality control gel, see Second Quality Control Gel on page 81.

You will remove sample from the plate at a specific point during the thermal cycler 
program.

4. When the program is finished, remove the plates and proceed immediately to Stage 
7 – Sample Hybridization on page 84.

The full volume must be picked up and dispensed each time to ensure that all of
the HY Digest Mix is flushed from the pipette tip.

Do not freeze samples at this stage of the protocol. Proceed directly to the next
stage.

Figure 3.53
Meg Hydigest-a Thermal Cycler Program

If running a second QC gel, remove 4.0 μL 
of each sample when the timer reads 5:00 
remaining for the second 37°C hold.
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SECOND QUALITY CONTROL GEL

To run a second quality control gel:

1. When the timer reads 5:00 minutes remaining for the second 37°C hold 
(Figure 3.53), press Pause.

2. Remove the plate from the thermal cycler and place on the bench top.

3. Remove the adhesive film from the plate.

4. Remove 4.0 μL of each reaction for the gel.

5. Add to each reaction 3 μL of loading buffer and 3 μL of DI water or 1X TE Buffer.

6. Reseal the plate with a new adhesive film.

7. Place the plate back on the thermal cycler and close the lid.

8. Press Resume to continue running the program.

9. Combine the 4.0 μL of each reaction with 3 μL loading buffer and 3 μL DI water 
or 1X TE Buffer.

10. Repeat these steps for each Hyb Plate.

11. Load and run the gels.

This operation should be performed quickly and should not exceed 5 minutes.
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EVALUATING THE SECOND QUALITY CONTROL GEL

A good second quality control gel will look like the one shown in Figure 3.54.

Three bands are in every well, indicating that incomplete digestion. We recommend 
going back to the Assay Plate and running the samples again from Stage 5 – Second 
PCR.

Figure 3.54
Good Second Quality Control Gel – Top Half Only

Figure 3.55
Bad Second Quality Control Gel

The positive control has been 
digested and the bands are 
identical in size to the sample 
bands.

The digested product is now 
smaller than the marker band.
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MARK EXPERIMENTS THAT WILL NOT BE HYBRIDIZED

At this point, you will want to indicate in GTGS any experiments that are not to be 
hybridized onto arrays.

To mark experiments that will not be hybridized:

1. In GTGS, expand the project, Tracking and Hyb Plates folders.

2. Select the appropriate Label Plate.

3. Open Tools > Set Well Status.

4. Right-click the well of each sample you want to fail and select Failed.

5. Click OK.
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Stage 7 – Sample Hybridization

ABOUT THIS STAGE

During this stage, you will add Hyb Cocktail to each sample. The samples are then 
placed on a thermal cycler and denatured.

After denaturation, each sample is loaded onto a GeneChip® Universal Tag Array 
(array) – one sample per array. The arrays are placed into a hybridization oven that has 
been preheated to 39°C. Samples are left to hybridize for 12 to 16 hours.

Each feature on an array contains multiple complementary tags (c-tags.) If you are using 
3K arrays, the array would have > 3000 tags.

The tag in the assay probe hybridizes to the c-tags on the array surface. If the sample 
is that of a homozygote, only one of the four types of allele-specific labelled probes will 
hybridize to the c-tags on the feature for the target SNP (for example, probes with the 
dATP label).

If the sample is that of a heterozygote, two of the four types of allele-specific labelled 
probes hybridize to the c-tags on the feature for the target SNP (for example, probes 
with the dATP label and probes with the dCTP label).

LOCATION AND DURATION

• Post-Amp Lab

• Hands-on time: 1 hour

• Time on thermal cycler: 6 minutes

• Hybridization time: 12 to 16 hours

EQUIPMENT AND MATERIALS REQUIRED

The following equipment and materials are required to perform this stage. Quantities 
shown are for processing 48 reactions (48 arrays).

Figure 3.56

Tag

Complimentary tag on array

 Label
Labelled, cleaved second PCR 
product hybridizes to oligos on 
Universal Tag Arrays
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KIT COMPONENTS REQUIRED

The following components are required from each GeneChip SNP Kit:

• Hyb Cocktail

THAW REAGENTS

To thaw the reagents:

1. Wrap the Hyb Cocktail in aluminum foil.

2. Allow to thaw on the bench top.

3. Place on ice until ready to use. 

Table 3.9
Equipment and Materials Required for Stage 7 – Sample Hybridization 

Quantity Item

1 Aluminum foil, 1 roll

1 Centrifuge, plate

48 Clear film for arrays (enough for one per array; quantities can vary)

48 Universal Tag Arrays (quantities can vary)

2 Hyb Plates containing samples from the previous stage

1 Hybridization oven with trays

1 Ice container, filled with ice

1 Marking pen, fluorescent or water soluble

2 MicroAmp Clear Adhesive Films

1 Microfuge

2 Plate holders (preparation racks)

1 Reagent reservoir, 50 mL

2 Thermal cyclers, 96-well GeneAmp PCR System 9700 

Hyb Cocktail is light sensitive. Do not expose to light.
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PREPARE THE GENECHIP® UNIVERSAL TAG ARRAYS

To prepare the arrays:

1. Cover the hybridization oven with aluminum foil to prevent light from entering.

2. Turn the hybridization oven on now and set to 39°C.

3. Remove arrays from the 4°C refrigerator.

4. Unwrap the arrays and place window-side up on a clean bench top.

5. Cover the window of each array with a piece of clear film.

6. Turn over each array so that the window faces down.

7. Write a number on each array (Figure 3.58) using a water soluble or fluorescent 
marking pen, keeping the arrays in numerical order.

For example, you might number the arrays 1, 2, 3 and so on.

8. Insert a 200 μL pipette tip in the upper right septum of the array.

Figure 3.57
Applying Clear Film to Array Window

Figure 3.58
Array With Sample Numbering
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9. Allow the arrays to warm to room temperature.

ADD THE HYB COCKTAIL

To add the Hyb Cocktail:

1. Using a P200 pipette, aliquot 75 μL (150 μL) Hyb Cocktail to each tube in one set 
of 12 strip tubes.

2. Using a 12-channel P200 pipette, aliquot 30 μL of Hyb Cocktail to each reaction 
on the Hyb Plates (final volume approximately 94 μL).

3. Mix by pipetting up and down 10 times.

4. Seal Hyb Plates with a new adhesive film.

5. Spin down the plates at 1000 rpm for 30 seconds.

6. If not immediately proceeding to Denature Samples below, Hyb Plates can be stored 
at −20°C for up to 2 days.

DENATURE THE SAMPLES

To denature the samples:

1. Place each Hyb Plate on a thermal cycler, and run the Meg Denature program 
(Figure 3.59.)

2. Immediately after the 6 minute denature:

A. Remove Hyb Plates from the thermal cycler.

B. Place on ice.

C. Cover with aluminum foil to protect from light.

D. Cool for 2 minutes.

E. Spin down at 1000 rpm for 30 seconds.

To ensure that the data collected during scanning is associated with the correct
sample, number the arrays in a meaningful way. It is critical that you know which
sample is loaded onto each array.

Hyb Plates can be stored at –20°C for up to 2 days.

We recommend freezing and thawing stored plates ONE TIME ONLY. For a given
set of samples, do not freeze and thaw plates more than once during the protocol.

Final Mix Consists of:

∼ 64 to 68 μL Sample 

+ 30 μL Hyb Cocktail

∼ 94–98 μL Total
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LOAD REACTIONS ONTO ARRAYS

To load reactions onto the arrays:

1. In GTGS, expand the Project, Tracking and Hyb Plate folders.

2. Right-click the appropriate Hyb Plate and select Hyb on Arrays.

3. Scan the Hyb Plate barcode and press Enter.

The Hyb on Arrays window appears (Figure 3.60 on page 88). Notice the top field 
of this window prompts you as to which reaction to load onto an array. When an 
array barcode is scanned, the software highlights the next sample to be loaded.

Figure 3.59
Meg Denature Thermal Cycler Program

To ensure that the data from the scanner is associated with the correct sample, you
must keep track of which sample is loaded onto which array. Follow the transfer
instructions displayed in the Hyb on Arrays window (Figure 3.60).

Figure 3.60
Hyb on Arrays Window. The software indicates by well designation which reaction is to be loaded 
onto an array. After the array barcode is scanned, the software highlights the well of the next 
reaction to be loaded.

Do not leave on thermal cycler.

Place samples on ice immediately after 6 minutes. 
Keep covered until ready to hybridize onto arrays.
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4. Working 24 arrays at a time:

A. Set a single channel pipette to 90 μL.

B. Pipette 90 μL of reaction from the plate and well specified in the Hyb on Arrays 
window, and load it onto an array through the lower left septum (Figure 3.61).

C. Remove the pipette tip from the upper right septum.

D. Scan the array barcode.

E. Place the array in a hybridization oven tray.

F. When the tray is full, place and secure the tray in the oven.

G. Repeat this process until all of the reactions have been loaded onto arrays and 
placed in the hybridization oven.

5. Ensure that the trays are seated properly in the oven carousel.

6. Set the oven speed to 25 rpm.

7. Leave the arrays in the oven for 12 to 16 hours.

8. In GTGS, click Next, then click Save.

What happens next depends on whether GTGS is configured to communicate with 
GCOS, or is configured to write sample files (.arr) for AGCC. See the AGCC and GCOS 
Compatibility Modes chapter of the GeneChip® Targeted Genotyping Software User Guide 
for more information about GCOS and AGCC modes.

Figure 3.61
Loading Sample Onto an Array

Place trays in the oven as soon as the arrays are loaded. Do not leave loaded arrays
on the bench top for more than 5 minutes.
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If you are using AGCC:

1. Select a new or existing folder within the AGCC data root used by the computer 
that will wash and scan your arrays.

GTGS will create sample files (.arr) in this folder, which AGCC needs before arrays 
are washed or scanned.  AGCC will create data files in this same folder when the 
arrays are scanned.

2. Click Save.

3. Check the AGCC Portal to ensure that the information from GTGS has been 
transferred and detected (indexed) by AGCC.

Indexing may take up to 10 min after files are added to the AGCC data root.

4. Click Close to close the Hyb on Arrays window.

If AGCC has not indexed the GTGS-created .arr files by the time the arrays are first
washed or scanned, then AGCC will itself create .arr files, which is a problem. When
AGCC creates .cel files, the names will be based on the full array barcode.

If this occurs, GTGS will not be able to load the .cel files. The reason is that GTGS
expects the .cel files to have a name based on the experiment name used in GTGS.
This name is an abbreviation of the full array barcode. 

If you accidentally save these files to the wrong location, you can also move your
sample files to the correct location before the arrays are washed and scanned.

Figure 3.62
AGCC data root 
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If you are using GCOS:

After several seconds, a message should appear confirming that the experiments have 
been registered with GCOS.

1. Check GCOS to ensure that the infomration from GTGS has been transferred.

2. Click Close to close the window.

For both AGCC and GCOS, you can click the Arrays folder icon to see a list of arrays 
that have been barcode scanned. You will also see information about each array in the 
right pane (Figure 3.63).

Figure 3.63
Arrays Icon Expanded and Array Tab



92 Affymetrix GeneChip® Scanner 3000 Targeted Genotyping System User Guide
Stage 8 – Stain and Wash

ABOUT THIS STAGE

During this stage, the arrays are loaded onto a GeneChip® Fluidics Station (fluidics 
station). Each array is washed and stained in preparation for scanning.

LOCATION AND DURATION

• Post-Amp Lab

• Hands-on and wash time: approximately 6 hours

EQUIPMENT AND MATERIALS REQUIRED

The following equipment and materials are required to perform this stage. Quantities 
shown are for processing 48 arrays. The number of arrays processed can vary.

KIT COMPONENTS REQUIRED

The following GeneChip SNP Kit components are required for this stage:

• Buffer H

• Stain Cocktail

• Wash Soln A

• Wash Soln B

The instructions for this stage refer to GCOS fluidics station control software. For
Affymetrix GeneChip® Command Console users (AGCC), refer to the AGCC user’s
guide for instructions on controlling the fluidics station.

Stages 8 and 9 are run concurrently. As arrays come off the fluidics station, you will
load them onto the GeneChip® Scanner 3000 7G 4C and scan them.

Table 3.10
Equipment and Materials Required for Stage 8 – Stain and Wash

Quantity Item

1 Centrifuge, plate

2 Conical tubes, 15 mL

48 Eppendorf tubes, Amber, 2.0 mL (1 tube per array; actual quantities required may 
vary)

48 Eppendorf tubes, Natural, 2.0 mL (1 tube per array; actual quantities required 
may vary)

48 Universal Tag Arrays from the previous stage (quantity can vary)

1 Ice container, rectangular, filled with ice
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PRIME THE FLUIDICS STATION

To prime the fluidics station:

1. Remove Wash Solutions (Solns) A and B from all kits being used.

1. Turn on the fluidics station and:

A. Place Wash Solns A and B in the designated positions.

B. Fill the dH2O container.

C. Empty the waste container.

2. Launch GCOS and:

A. Click the Fluidics button. 

B. Navigate to Run → Fluidics → Protocol.

C. Open the Protocol drop-down list and select Prime_450.

D. Select the All Modules button.

E. Click Run.

F. Follow the instructions on the monitor.

The displays on the fluidics station for each module will read Priming done when 
the program is finished.

Figure 3.64
Selecting the Prime_450 Protocol
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PREPARE REAGENTS

To prepare the reagents:

1. From each kit being used, remove the Buffer H and Stain Cocktail.

2. Mix the Stain Cocktail by inverting 5 times.

3. Wrap the Stain Cocktail tube in aluminum foil and place on ice.

4. Thaw Buffer H on the bench top.

5. Spin down Buffer H and mix by pipetting up and down.

6. Keep all reagents on ice until ready to use.

PREPARE THE STORAGE COCKTAIL

To prepare the Storage Cocktail:

1. In a 15 mL conical tube, add the reagents listed in Table 3.11 in the order shown.

Be sure to dilute Buffer H using Wash Soln B; do not use water.

2. Cap the tube and mix gently by inverting.

ALIQUOT THE STAIN AND STORAGE COCKTAILS

To aliquot the stain and storage cocktails:

1. For every array, aliquot 190 μL of Stain Cocktail to an amber 2.0 mL Eppendorf 
tube (one tube per array).

2. Keep the tubes on ice and covered to protect from light until ready to use.

3. For every array, aliquot 190 μL of Storage Cocktail to a clear 2.0 mL Eppendorf 
tube (one tube per array.)

4. Keep the tubes on ice until ready to use.

Stain Cocktail is light sensitive. Keep protected from light.

Table 3.11
Storage Cocktail

Reagent 1 Array 24 Arrays
(2 extra arrays)

48 Arrays
(4 extra arrays)

Wash Soln B 179 µL 4.65 mL 9.31 mL

Buffer H 11.4 µL 296 µL 593 µL

Total 190 µL 4.95 mL 9.90 mL

Stain Cocktail is light sensitive. To avoid exciting the dyes, keep tubes protected
from light.
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LOAD ARRAYS ONTO THE FLUIDICS STATION

To load arrays onto the fluidics station:

1. Remove eight arrays from the hybridization oven.

2. Place each array on a fluidics station, but do not engage the wash block.

3. In GCOS, click the Fluidics button  .

4. Select the appropriate module.

5. Open the Protocol menu and select TrueTag_Chip_Wash_R7_450.

This step is required when you scan the first array only.

6. To scan the array barcode:

A. Highlight the barcode field (or click in the field if this is the first run).

If this is the first run of arrays, the Barcode field is empty. You must still click 
in the Barcode field before scanning each of the first four arrays.

B. Scan the array barcode.

C. Wait for the Experiment field to update (Figure 3.66).

After the barcode is scanned, GCOS checks the experiment list and automatically 
updates the Experiment field. The experiment name is typically a truncated 
version of the array barcode.

Leave remaining arrays in the hybridization oven until ready to wash.

Figure 3.65
Selecting a Wash Protocol on the Fluidics Station

You must wait for the Experiment field to update after scanning the array barcode.
If you click Run before the field updates, the scanner will not be able to scan the
array. A message stating that the array was not hybridized is displayed.
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An error message is displayed if GCOS cannot find an experiment that corresponds 
with the array barcode.

7. Click Run (or press Enter) to proceed to the next module and scan the array 
barcode.

8. Repeat until all of the barcodes have been scanned and entered.

9. Follow the prompts on the fluidics station as follows:

A. When the display reads Load Cartridge, engage the wash blocks.

B. When the display reads Load Stain in 1, Store in 2 (Figure 3.67) :

1) Load a tube of Stain Cocktail in position 1.

2) Load a tube of Storage Cocktail in position 2. 

3) Load an empty tube in position 3.

C. Lower the needles to start the program.

Figure 3.66
Experiment Field

Figure 3.67
Tube Positions on the Fluidics Station

Updated automatically by 
GCOS after the array barcode 
is scanned.

Stain Cocktail in
position 1

Storage Cocktail in
position 2

Empty tube in 
position 3
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10. If the scanner is not turned on:

A. Launch GCOS first.

B. Turn the scanner on.

The scanner must warm up for 10 minutes before scanning arrays.

REMOVE ARRAYS FROM THE FLUIDICS STATION

To remove arrays from the fluidics station:

1. When the Remove Cartridge prompt is displayed, remove the array.

2. Inspect the array for air bubbles. If found:
• For small bubbles, gently swipe the array on the bench top to move the bubble 

out of window (Figure 3.68).
• For larger bubbles:

1) Place the array back on the fluidics station.

2) Re-engage the wash block.

3) Allow the program to finish. 
The array is automatically drained and refilled with Storage Cocktail. 
Repeat this process as many times as necessary.

3. Reinspect the array and repeat the previous step if necessary.

4. Re-engage the washblock to restart the TrueTag_Chip_Wash_R7_450 script 
and allow it to finish.

5. At the prompt, remove and discard the stain and storage cocktail vials from 
positions 1 and 2.

Protocol Done is displayed on the fluidics station when the script is finished. Leave 
the empty tube in position 3.

6. Place the arrays face down and cover the septa with Tough Spots.

The TrueTag_Chip_Wash_R7_450 script is designed to pause automatically so that
you can check the arrays for bubbles, and reinsert the arrays to drain and refill as
many times as necessary.

Figure 3.68
Swiping an Array to Dispel Air Bubbles
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7. Remove the clear film from each array window.

8. Proceed immediately to Stage 9 – Scan Arrays on page 99 and scan the arrays.

PROCESS THE REMAINING ARRAYS

To process the remaining arrays, repeat the steps listed under Load Arrays onto the 
Fluidics Station on page 95 and Remove Arrays from the Fluidics Station on page 97.

SHUT DOWN THE FLUIDICS STATION

To shut down the fluidics station:

1. Remove Wash Solns A and B and replace with distilled H2O (dH2O).

2. Place tubing in dH2O.

3. Place empty tubes in positions 1, 2 and 3.

4. Select the All Modules button.

5. Run the protocol called Shutdown_450 (Figure 3.69).

6. Turn off the fluidics station.

Do not allow edges of Tough Spots to overlap the large center circle of the array. If
tags overlap, the array may get stuck in the scanner.

Load new tubes of Stain and Storage Cocktail for each array. Leave the empty tube
in position 3.

Figure 3.69
Shutting Down the Fluidics Station
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Stage 9 – Scan Arrays

ABOUT THIS STAGE

During this stage, the arrays are loaded onto the GeneChip® Scanner 3000 7G 4C 
(Scanner 3000 7G 4C). Each array is scanned individually, and the data collected is 
stored in four files referred to as .cel files. Each .cel file contains the data for one 
channel (A, C, G or T). The naming convention for AGCC .cel files created by GTGS 
is <abbreviated barcode>_<channel designation>.cel. The naming convention for GCOS 
.cel files is <abbreviated barcode><channel designation>.cel. The channel designation is 
A, B, C or D.

AGCC Example: @1234567-12345_A.cel

GCOS Example: @1234567-12345A.cel

Data is generated by collecting light from four different wavelengths – one for each 
channel. The amount of light emitted by each feature on the array is collected, and the 
background is subtracted.

If the sample is from a homozygote, only a single wavelength of light is emitted from 
the feature for the target SNP. If the sample is from a heterozygote, two different 
wavelengths of light are emitted.

LOCATION AND DURATION

• Post-Amp Lab

• Hands-on and scanning time: approximately 4 to 5 hours

EQUIPMENT AND MATERIALS REQUIRED

The following equipment and materials are required to perform this stage. Quantities 
shown are for processing 48 arrays:

The instructions for this stage refer to GCOS scanner control software. For
Affymetrix GeneChip® Command Console users (AGCC), refer to the AGCC user’s
guide for instructions on controlling the scanner.

Stages 8 and 9 are run concurrently. As arrays come off the fluidics station, they are
loaded onto the Scanner 3000 7G 4C and scanned.

Table 3.12
Equipment and Materials Required for Stage 9 – Scan Arrays

Quantity Item

1 can Compressed air

1 GeneChip Scanner 3000 7G 4C

48 Arrays from the previous stage (quantities can vary)
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PREPARE THE SCANNER

If the scanner is not already on and warmed up:

1. Launch GCOS first. 

2. Turn on the scanner.

3. Allow the scanner to warm up for 10 minutes before scanning arrays.

LOAD THE ARRAYS

To prepare the arrays for scanning:

1. Inspect the windows for dust, lint or other blemishes.

2. If necessary, clean the array window using compressed air.

3. Load each array the scanner carousel, starting at position 1.

The carousel holds 48 arrays.

SCAN THE ARRAYS

To scan the arrays:

1. Click the Start button. 

The GeneChip Scanner dialog box is displayed.

2. If the arrays are:
• At room temperature, select First 4 arrays at room temperature.
• If arrays are not at room temperature, deselect the check box. Bringing arrays 

to room temperature takes approximately 5 minutes.

3. If:
• None of the arrays have been scanned, leave Allow rescans deselected.
• One or more of the arrays have already been scanned, select the Allow rescans 

check box.

The scanner will identify arrays that have already been scanned. When rescanned, 
the associated files will have the suffixes such as _2A, _2B, _2C, and _2D added 
to the filename (A for the first rescan, B for the second rescan, and so on.)

4. Click OK.

The scanner processes approximately 11 arrays per hour.

Figure 3.70
GeneChip Scanner Dialog Box
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5. To view the scanning process, open View → Scan in Progress.

The scanner must finish autofocusing before you can view the scan.

6. When scanning is finished, do one of the following:
• Leave the arrays in the carousel where they are held at 15°C.
• Remove and store the arrays at 4°C until no longer needed.

ADDING ARRAYS DURING AN AUTOLOADER RUN

To add arrays while an AutoLoader run is in progress:

1. Do one of the following:

A. Click the Add icon.

B. Open Run → Add Chips, .

The GeneChip Scanner window appears (Figure 3.71).

2. Click Add after Scan.

3. Wait until the scanner is finished scanning the current array.

4. When the status on the scanner reads Autoloader Unlock, open the scanner and 
add the arrays.

5. Close the scanner.

6. When the following message is displayed, click OK.

We strongly recommend rescanning arrays within 6 to 24 hours of the first scan if
necessary. Data quality may be degraded if arrays are rescanned after 24 hours.

Figure 3.71
GeneChip Scanner Window

Do not use the Add Now feature. Use only the Add after Scan feature when working
with Universal Tag Arrays.

Figure 3.72
Resume Prompt
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7. Do one of the following:

• Click the Start icon.

• Click the Resume icon, .

• Open Run → Resume Scan.

SHUTDOWN THE SCANNER

To shutdown the scanner:

Turn off the scanner by pushing the power button.
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Rescanning Arrays

GUIDELINES FOR RESCANNING ARRAYS

Guidelines for rescanning arrays are as follows.

REWASH ARRAYS

To rewash arrays:

1. Insert a P-200 pipette tip in the upper-right septum of the array.

2. Pipette out the Storage Cocktail from the array.

3. Pipette fresh Wash Solution B through the lower left septum as follows:

A. Pipette up and down 5 times to fill and drain the array.

B. Repeat the fill and drain with fresh Wash Solution B two more times.

C. Remove Wash Solution B from the array.

4. Slowly refill the array with fresh Storage Cocktail (approximately 100 μL), ensure 
there are no air bubbles and rescan immediately.

RESCAN THE ARRAY

To rescan the array:

1. Load the array into the autoloader.

2. Rescan the array as you would normally.

3. At the prompt Allow Rescans, select Yes.

When the AGCC or GCOS software reads the barcode, it will recognize that this 
array has already been scanned. AGCC or GCOS will add suffixes (_2A, _2B, _2C, 
and _2D) to the associated filenames to reflect the fact that they are rescans.

We strongly recommend that arrays be rescanned if necessary within 6 to 24 hours
of the first scan. Scanning arrays after 24 hours can result in degraded data.

Table 3.13
Guidelines for Rescanning Arrays

If … Then …

there is no image when viewing the .dat 
file (white screen)

rewash the array with fresh Wash Solution B and 
rescan. See Rewash Arrays  below.

lint, dust or bubbles are present clean the array window or rewash the array as 
appropriate and rescan. See Rewash Arrays  below.

data quality is poor rescan the array.

the image does not grid properly (.cel file 
is missing)

do not rescan the array. Manually apply the grid to 
the array image and generate the missing .cel file. 
See Manually Regridding Arrays on page 118.
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Deleting Projects and Project-Related Information

DELETING A PROJECT

To delete a project, you must delete the project components in the reverse order from 
which they were created. 

For example, if there are cluster results in the Genotype Results folder, you must:

1. Delete each cluster genotype that is in the Genotype Results folder.

2. Delete all of the experiments listed under the Array Data icon in the Experiment 
QC Summary.

Experiments may be deleted individually or all at once. If you are using GCOS, 
you may also want to go to GCOS Manager and delete all experiments associated 
with the project.  If you are using AGCC, you may also want to go to the folder 
containing .arr and .cel files, and move or delete these as well.

3. Delete the arrays from the Arrays folder.

4. Delete each plate in the Hyb Plates folder.

5. Delete each plate in the Label Plates folder.

6. Delete each plate in the Assay Plates folder.

7. Delete each plate in the Anneal Plates folder.

8. Delete each plate in the Sample Plates folder.

9. Delete the project icon.

DELETING CLUSTER GENOTYPE RESULTS

To delete cluster genotype results:

1. Right-click the cluster name.

2. Select Delete.

3. Click Yes.
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DELETING EXPERIMENTS

Experiments can be deleted only if they are not included in any cluster genotyping 
results.

To delete individual experiments:

1. Click the Array Data icon for your project.

2. Click the Experiment QC Summary tab.

3. Right-click anywhere in the row of the experiment you want to delete and select 
Delete.

If you cannot select Delete, the experiment is included in cluster genotype results. 
You must delete the cluster genotype results before you can delete the experiment.

4. Click OK.

To delete all experiments at once:

1. Right-click the Array Data icon for your project.

2. Select Delete All Experiments.

The status bar at the bottom of the the application window will show the deletion 
progress. Do not force quit the application during this operation, or all of the 
experiments will be restored.  Since restoring all experiments takes some time, the 
application may be unresponsive until the SQL Server has finished this task.

DELETING ARRAYS

You should delete arrays only after the associated Array Data experiments have been 
deleted.

To delete arrays:

1. Select the arrays folder.

2. In the right pane, right-click the set of arrays to delete and select Delete.

3. Click Yes to confirm deletion of each selected array.

To delete multiple arrays, simply hold down the Enter key to quickly accept each 
confirmation message.

DELETING ANNEAL, ASSAY, LABEL AND HYB PLATES

You can delete plates as long as there are no arrays hybridized with samples that 
originated from these plates.

To delete these plates, you must delete them in reverse order starting with the Hyb 
Plate.

To delete plates:

1. Select the relevant plates folder.

2. Right-click the set of plates to delete, and select Delete.  

3. Click Yes.  

To delete multiple plates, simply hold down the Enter key to quickly accept each 
confirmation message.
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DELETING SAMPLE PLATES

You can delete a sample plate as long as it is not included in a project. If referenced by 
any projects, you must first remove the sample plate from those projects, then delete 
the sample plate.

To delete a sample plate:

1. Delete any projects that reference the sample plate.

See Deleting a Project on page 104.

2. Open the menu in the left pane of the GTGS window and select Samples.

3. Expand the Sample Plates folder.

4. Right-click the sample plate name and select Delete.

You can also select Edit → Delete. If you cannot select Delete, the sample plate 
has been used in a project that still exists.

5. Click Yes.

DELETING SAMPLE INFO

If a sample name in the Sample Info table does not exist in any Sample Plate, you can 
remove these samples.

To delete Sample Info:

1. Open the menu in the left pane of the GTGS window and select Samples.

2. Right-click the Sample Info icon and select Remove Unused Sample Info.

3. Click Yes.

DELETING ASSAY PANELS

You can delete an assay panel as long as it is not included in a project. If referenced by 
any projects, you must first delete those projects, then delete the assay panel.

To delete an assay panel:

1. Delete any projects that reference the assay panel.

See Deleting a Project on page 104.

2. Open the menu in the left pane of the GTGS window and select Assay Panels.

3. Expand the Assay Panels folder.

4. Right-click the assay panel name and select Delete.

You can also select Edit → Delete.

5. Click Yes.
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GeneChip® Fluidics Station Troubleshooting
FLUID NOT DETECTED

Problem: Fluid not Detected

The GeneChip® Fluidics Station (fluidics station) has detected a problem with either 
the Stain Cocktail or the Storage Cocktail. This problem can be caused by:

• No solution in a tube

• Solution not prepared correctly

• Wrong solution in a tube

Messages Displayed

On the Instrument Control Workstation, you will see the following messages (the 
word position refers to the fluidics station module in these messages):

Solution

To resolve the error and resume the wash and stain operation:

1. Determine which cocktail or solution is causing the problem by looking at the Step 
field. 

2. If the stain cocktail is causing the problem:

A. Run the protocol RECOVER1_450 (Figure 4.2).

This section covers troubleshooting of issues using GCOS fluidics and scanner
control software. Affymetrix GeneChip Command Console (AGCC) users should
refer to the AGCC User's Guide for how diagnose and recover from fluidics,
scanner, or array-related problems.

Figure 4.1
Fluid Not Detected
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B. Follow the prompts on the fluidics station LCD.

C. When finished, a message similar to the one outlined in red (Figure 4.3) 
appears.

D. At the prompt, remove the array from the wash block.

E. Re-engage the wash block and allow the protocol to finish.

3. If the storage cocktail is causing the problem:

A. Run the protocol RECOVER2_450.

B. Follow the same steps used for RECOVER1_450 above.

4. Open the Protocol menu and select TrueTag_Chip_Wash_R7_450.

5. Highlight the barcode field and scan the barcode of the array that failed.

6. Click Resume.

Figure 4.2
Recover1_450 Protocol

Figure 4.3
Fluidics Protocol Complete
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7. At the prompt, click OK.

Figure 4.4
Array Barcode in Experiment Field

Figure 4.5
Confirm That Recovery Steps Complete
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Troubleshooting the GeneChip® Scanner 3000 7G 4C

SCANNING STOPPED PREMATURELY

Problem: Scanning Stopped Prematurely

On the Instrument Control Workstation, if the scanner should be actively scanning 
but the Scan Status reads Ready, the scanner has lost communication with the 
workstation.

The upper blue light on the scanner will be illuminated, indicating that the door is 
locked and that the instrument should be scanning.

Solution

To re-establish communication and continue scanning:

1. On the GeneChip® Operating Software (GCOS) tool bar, click the Stop button.

The upper light on the scanner will turn off indicating the door is unlocked.

2. At the prompt, click OK.

3. Open the scanner door, and remove the arrays that have been completely scanned 
(scan status reads Scan Complete).

If you do not remove the arrays that have already been scanned, those arrays will 
be scanned again once operation resumes.

4. Reposition the arrays, or add additional arrays so that there is an array in position 
1 of the autoloader.

5. Close the scanner door.

6. Click the Start button.

7. At the prompt, select Allow Rescans.

8. Click OK.
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AUTOFOCUS ERROR MESSAGE

Problem: Autofocus Error Message

If the clear film was left on the array, you will see the message outlined in red below 
on the Instrument Control Workstation:

Solution

To fix the problem and continue scanning:

1. On the GCOS tool bar, click the Stop button.

The upper light on the scanner will turn off indicating the door is unlocked.

2. Click OK when the prompt appears in GCOS.

3. Open the scanner door, and remove the array.

4. Remove the clear film and place the array back in the autoloader.

5. Close the scanner door.

6. Click the Start button.

7. Click OK when the prompt appears.

EXPERIMENT NOT HYBRIDIZED MESSAGE

Problem: Experiment not Hybridized Message

On the scanner you will see the message: The experiment <experiment name> has not been 
hybridized (example outlined in red below):

Cause

This error can occur if you do not allow the Experiments field to update on the fluidics 
station when scanning array barcodes. When the field is not allowed to update, the fact 
that the array has been stained and washed is not registered with GCOS (even though 
the error message says the experiment has not been hybridized). 

Figure 4.6
Message Displayed in GCOS When Clear Film Left on Array Window

Figure 4.7
Error Message – Experiment Not Hybridized
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Even though the array barcode is passed to GCOS, the software does not advance the 
status of the array to scan. Therefore, when you try to scan the array, GCOS has no 
record of the barcode and displays this error message.

Solution

To advance the status of an array to scan:

1. Click the Workflow Monitor button (or select Workflow Monitor from the 
Run menu).

2. In the window that appears, open the Assays menu and select Universal.

A list of arrays may appear.

3. If no list of arrays appears, check you filter settings as follows:

A. Open Tools → Filters . . .

B. Reset any incorrect fields and click Refresh.

C. If no list of arrays, deselect the Date check boxes and click Refresh.

Figure 4.8
Selecting the Workflow Monitor

Figure 4.9
Selecting Universal
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D. Click OK.

4. Locate and right-click the barcode for the array, then select Advance to Scan.

5. Put the array back into the scanner, and scan the array.

Figure 4.10
Selecting Advance to Scan
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Troubleshooting and Generating Missing .cel Files

CAUSES OF MISSING .CEL FILES

On occasion, the scanner may generate .dat files but no .cel files for a particular array 
or group of arrays. Causes are:

• A software error occurred
When many .cel files are missing, this is typically the cause.

• A gridding error occurred

DETERMINE THAT .CEL FILES ARE MISSING

The first indication that .cel files are missing is when you import experiment data into 
Affymetrix GeneChip® Targeted Genotyping Analysis Software (GTGS). The Import 
Experiment Data window in GTGS displays:

• The total number of experiments you attempted to process

• The number of experiments actually processed

• The number of experiments that were skipped

To generate missing .cel files, you must first determine the name of the corresponding 
.dat files. The two methods we recommend are:

• Viewing the Messages field of the Import Experiment Data window in GTGS

Use this method if less than 5 experiments were skipped due to missing .cel files. 
See Locate .dat Filenames in GTGS on page 115.

• Using the MegAllele™ Processing tool in GeneChip® Operating Software (GCOS)

Use this method if more than 5 experiments were skipped due to missing .cel files. 
See Locate the .dat File in GCOS on page 119.

LOCATE .DAT FILENAMES IN GTGS

To identify the .dat files that correspond to missing .cel files in GTGS:

1. In GTGS, look at the Import Experiment Data window.

2. Look for an error similar to the one shown below in the Messages field.

ERROR DAT file exists but CEL file does not exist: 
\\DB4YGL51\GCLims\Data\(a)4004602-02693D.cel

Based on the .cel filename, you know that the name of the corresponding .dat file 
is (a)4004602-02693D.dat.

Refer to the Affymetrix GeneChip® Targeted Genotyping Analysis Software User Guide for 
more information.
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GENERATE MISSING .CEL FILES

Restart the Instrument Control Workstation

If the .cel files are missing due to a software error, restart the Instrument Control 
Workstation. Restarting the workstation will force the creation of the missing .cel 
files. Once generated, reimport your experiment data into GTGS.

Manually Grid the .dat Files

If the .cel files are missing due to gridding errors, you must manually regrid the .dat 
files. Follow the instructions below to locate the .dat filenames and manually apply the 
grid.

Locating .dat Filenames in GCOS

To locate .dat files that correspond to missing .cel files in GCOS:

Click the MegAllele Processing button.

The Status window displays the messages “Searching for unprocessed MegAllele 
files…” and “Reading .dat file headers…” as shown in Figure 4.12.

Next, a table listing the .dat files is displayed (Figure 4.13).

Figure 4.11
MegAllele Processing

Figure 4.12
Missing CEL File Error Messages

Figure 4.13
List of DAT Files

Messages displayed by
GCOS while searching

for missing .cel files.
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The software searches the entire list of .dat files in the system; therefore, this procedure 
can take some time. The search is complete when the Status window displays the 
message “<number> unprocessed MegAllele files found (example shown in Figure 
4.14).

Opening .dat Files to Fix Gridding Errors

To open .dat files:

1. Do one of the following:

• Select the filename and click the Open button.

• Double-click the filename.

• Click the Select All icon; then click the Open button.

2. When you see the message Cell grid is not aligned in C:\<path to .dat file>, click OK.

The DAT file opens and is displayed with an un-aligned grid.

3. Manually align the grid and click Calculate CEL Intensity.

The .cel file is generated automatically.

For instructions on manually aligning a grid, see Manually Aligning a Grid on 
page 120.

Figure 4.14
Unprocessed MegAllele Files Message

Figure 4.15
Opening a DAT File
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Manually Regridding Arrays

WHAT YOU WILL SEE

When scanning arrays, the gridding step can sometimes fail. When this occurs, a .cel 
is not generated from the corresponding .dat file. You can determine that a .cel file has 
not been generated in various ways:

• When importing .cel files to GTGS, an error message is displayed stating that a 
particular .cel file could not be found.

• In GCOS, the following gridding error message is displayed in the Scan Status 
column of the lower left window:
Failed to align grid. Error returned is: Failed to align the grid in Checkerboard Grid Align. 
Corrective action to manually align the grid.

• In GCOS in the lower right window, no information is displayed for .cel files that 
were not generated. In the example below, no .cel file was generated for the A 
channel for experiment (a)4003192-25600. Only channels B, C and D have .cel files 
(Figure 4.17).

Figure 4.16
Gridding Error Message

Figure 4.17

Full text of message displayed in Scan Status window.
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Figure 4.18 shows a .dat file that did not grid properly. You can see how the grid is 
not aligned with the edges of the array image.

LOCATE THE .DAT FILE IN GCOS

To locate the .dat file on the Instrument Control Workstation:

1. On the workstation, expand the Image Data folder.

2. Double-click the .dat file that corresponds to the missing .cel file.

3. Click OK.

The array image is displayed.

Figure 4.18
Example of .dat File That Did Not Grid Properly

Figure 4.19
Image Data Folder and DAT Files

Corner of grid

Corner of array image
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MANUALLY ALIGNING A GRID

To manually align a grid:

1. If a grid is not already displayed over the array image, click the Grid button.

The Grid button is located in the lower right corner of the array image window.

The misaligned grid is applied over the array image (Figure 4.21).

2. Perform a preliminary alignment as follows:

A. Click and hold the left mouse button on a corner of the grid.

B. Drag and align the grid over the array image.

C. Repeat this procedure for each corner of the grid.

3. Perform a fine alignment as follows:

A. Jump to a corner of the grid using one of these methods:

- Press F5, F6, F7 or F8 on the keyboard
- Click the corners icon to expand it; then click one of the corners (Figure 4.22).

Figure 4.20
Grid Button

Figure 4.21
Misaligned Grid

Grid button

Click and drag each corner of the grid 
to each corner of the array image



chapter 4  |  Troubleshooting 121
B. Click and drag the corner of the grid over the array image as shown in the 
following illustration.

C. Click Recalculate Cel Intensity.

GENERATE A .CEL FILE

To generate a .cel file:

1. Place the mouse over the image, right-click and choose Recalculate Cell 
Intensity.

2. Update the .dat and .cel files in the Image Data and Cell Intensities folders as 
follows:

A. Open Tools → Filters → Refresh.

B. Click OK.

Figure 4.22
Corners Icon

Figure 4.23
Grids Before and After Fine Alignment

Corners icon
Click one of the boxes to jump 
to the respective corner

Grid before fine alignment Grid after fine alignment
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Identifying Skipped Experiments

HOW TO IDENTIFY SKIPPED EXPERIMENTS

Two methods are available for identifying skipped experiments. You can:

• View the Import Experiment Data window as .cel files are being imported and 
processed.

• View the Experiment QC Summary table.

VIEWING THE IMPORT EXPERIMENT DATA WINDOW

Experiment data is imported to GTGS and processed via the Import Experiment Data 
window. Once the software is finished reading and processing .cel file data, look at the 
Processed/Skipped/Total field to see if any experiments were skipped. In the 
example shown in Figure 4.24, one experiment was skipped.

For instructions on troubleshooting skipped experiments via the Import Experiment 
Data window, refer to the Affymetrix GeneChip® Targeted Genotyping Analysis Software 
User Guide.

Figure 4.24
Identifying Skipped Experiments in the Import Experiment Data Window
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VIEWING THE EXPERIMENT QC SUMMARY WINDOW

If the Import Experiment Data window has already been closed, you can identify 
skipped experiments by looking at the Experiment QC Summary table. The columns 
that hold values for the QC metrics (QC Call Rate, QC Half Rate, and so on) will be 
empty as shown in Figure 4.25. Refer to the Affymetrix GeneChip ® Targeted Genotyping 
Analysis Software User Guide for information on QC metrics.

To troubleshoot skipped experiments found in the Experiment QC Summary table:

1. Select the Array Data icon for your project.

2. In the Experiment QC Summary table, look for rows where the QC Metric 
columns are empty (Figure 4.25).

3. Determine why the data was not imported as follows:

A. Right-click the Array Data icon for the project and select Import 
Experiment Data.

The Import Experiment Data window appears.

B. Look at the Ready to Process field for experiments that were skipped. 
The names of the experiments you identified in the Experiment QC Summary 
table should appear in the Ready to Process list.

C. Look at the Messages field and do one of the following:
- If the Messages field is empty, click Process. The software will run through 

the list of experiments again and will display error messages related to the 
skipped experiments.

- If the Messages field is not empty, scroll through the messages for the ones 
related to the skipped experiments.

Figure 4.25
Identifying Skipped Experiments in the Experiment QC Summary Table

Figure 4.26
Identifying Skipped Experiments

Skipped experiments

These experiments
correspond to the skipped

experiments in the
Experiment QC Summary

table
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Troubleshooting Failed Experiments

ABOUT DATA PROCESSING

Data processing occurs as .cel files are imported into GTGS. During processing, 
GTGS calculates and compares the results of each experiment against the following set 
of quality control metrics ():

• QC Call Rate

• QC Half Rate

• Signal to Background (median ratio)

• Controls Coefficient of Variation (Controls CV %)

Based on this analysis, GTGS automatically assigns the status of Pass or Fail to each 
experiment. The threshold for each of these metrics must be met for an experiment to 
be assigned the status Pass. If any metric is not met, the experiment is assigned the 
status Fail.

IDENTIFYING FAILED EXPERIMENTS

To identify failed experiment in GTGS:

1. Click the Array Data icon for your project.

2. In the Experiment QC Summary table, sort on the Hyb Date column so that the 
latest imports are displayed first.

As experiment data is imported into GTGS, it is appended to the bottom of the 
list.

3. Look at the Auto column for experiments with the status Fail.

For more information on GTGS and reviewing data quality, refer to the Affymetrix
GeneChip® Targeted Genotyping Analysis Software User Guide.

Table 4.1
Quality Control Metrics

Quality Control Metric Description Threshold

QC Call Rate % Estimated percentage of assays clearly 
genotyped.

Must be ≥ 80%

QC Half Rate % Estimated percentage of assays 
marginally genotyped.

Must be ≤ 10%

Signal to Background Median ratio of assay allele/non-allele 
channel signals (median signal to 
background ratio)

Must be ≥ 20

 Controls CV%
(Controls coefficient of variation)

Percent coefficient of variation of 
control feature signals.

Must be ≤ 30%
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TOOLS AVAILABLE FOR REVIEWING YOUR DATA

The following tools are available in GTGS for reviewing your data prior to cluster 
genotyping:

• Experiment QC Summary

• Experiment Metrics Chart

• Channel Metrics Chart

• Experiment Details including:

- Summary

- Channel Details

- Array View

For more information on these tools and how to work with them, refer to the 
Affymetrix GeneChip® Targeted Genotyping Analysis Software: User Guide.
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TROUBLESHOOTING FAILED EXPERIMENTS

To troubleshoot failed experiments:

1. Look at the QC Call Rate for the failed experiments.

2. Click the Experiment Metrics Chart tab.

3. Select these display options:

Y Axis: Call Rates % 

X Axis: Experiment Name

Table 4.2
Troubleshooting Failed Experiments

If … Then … Suggested Actions

Many experiments have low 
call rates

compare sample call 
rates to control call rates 
by toggling the Controls 
check box on and off.

If Kit Control data Auto status is Pass, but many experiments were 
automatically failed, the quality of your sample DNA is suspect. 
See About Your DNA Samples on page 2 for sample criteria.
If both samples and controls failed, an error was made while 
performing the protocol. Rerun the samples.

Individual experiments seem 
to have randomly failed

Open the Array View 
and look at the control 
features.

• If Kit Control data Auto status is Pass, but many experiments 
were automatically failed, the quality of your sample DNA is 
suspect. See About Your DNA Samples on page 2 for sample 
criteria.

• If both the border control features and the text are clearly seen 
(Figure 4.27), then the array hybridization and stain/wash steps 
were correctly performed. Possible cause: assay performed 
incorrectly prior to Stage 8 – Preparation for Sample 
Hybridization.

- Look at second stage gel. Was there product of correct size in 
all 4 lanes? If yes, then at some point between target digest 
and hyb on arrays something went wrong. Solution: rerun 
samples from stage 5 on.

- If the second stage gel looks bad, go to first stage gel. If first 
stage gel looks good, then rerun samples from stage 5 on. 

- If first stage gel bad, then rerun the samples from stage 1 on.

If control features are not 
uniform across the array

• there may be a 
hybridization problem

• the array may be 
defective

• Look at the Experiment QC Summary and sort on Controls CV %. 
If the value is over 30%, the experiment is failed automatically.

• Look at the .cel file borders in the Array view. 

Possible causes: 

• Hybridization oven stopped

• Temperature in Hybridization oven too high or too low

• Fluidics station error such as wrong buffers used. Look at log for 
errors.

• Excess stain.

Solution:

• Rewash and rescan the array. See Rescanning Arrays on 
page 103 for instructions.

• Rerun the samples.

• Arrays may be defective.
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To understand sample data quality more thoroughly, look at all of the X and Y axis 
display options in both the Experiment Metrics Chart and the Channel Metrics Chart. 
For example, in the Channel Metrics Chart the typical signal strength (signal-to-noise) 
of each nucleotide is displayed.

Figure 4.27
Controls Features Present; No Signal for Assay Features

Figure 4.28
Control Features Not Uniform
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In the Experiment Metrics Chart, signal-to-background correlates strongly with QC 
Call Rate. In this context, background is signal in the non-allele channels. When the 
QC Call Rate is high, signal-to-background is a more sensitive metric for detecting 
trends in data quality. Low signal-to-background can indicate one of the following:

• Low sample concentration

• Poor amplification 

• Sample contamination

High QC half rates can indicate:

• Sample contamination

• Reactions with multiple DNA samples mixed together



Chapter 5
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About Affymetrix GeneChip® Targeted Genotyping
Analysis Software
SOFTWARE OVERVIEW

Affymetrix GeneChip® Targeted Genotyping Analysis Software (GTGS) provides a 
full set of tools to help you generate and manage the highest quality genotypes using 
the MIP Assay Protocol. This software supports networked client-server environments 
with multiple users and large experimental data sets.

System management functionality includes:

• User management

• Protocol management

• Array definition management

Project management functionality includes:

• Experiment design

• Sample tracking through the genotyping process.

- See Project Management on page 141 for an overview.

- Instructions for using the software throughout the various steps of the protocol is 
presented in Chapter 3, Running the Protocol.

Data analysis functionality includes:

• Generating genotypes from the data collected by the GeneChip® Scanner 3000 7G 
4C (Scanner 3000 7G 4C).

• Managing and overseeing the quality of the array data stored in the Affymetrix 
GeneChip® Scanner 3000 Targeted Genotyping System database.

Refer to the Affymetrix GeneChip® Targeted Genotyping Analysis Software User Guide for 
further information and instructions.

System Management

USER MANAGEMENT

User management functions include:

• Adding users

• Activating and deactivating users

• Deleting users
A user cannot be deleted if the user name is associated with data.

• Modifying user properties

• Changing user names without logging out
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Adding Users

You must be logged in as admin to add users.

To add a new user:

1. In the left pane, open the menu and select Users.

2. Do one of the following:
• Open File → New User.
• Right-click the Users folder and select New User (Figure 5.1).

The User window appears.

3. In the Name field, enter a user name.

4. Optional: In the Description field, enter a description for the user.

5. Click Save.

When created, the user name and description are added to the table in the right 
pane of the Users window as shown in Figure 5.3.

Figure 5.1
Users window

Figure 5.2
Enter User Name and Description
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Deleting Users

A user cannot be deleted if the user name is associated with any experiments or data. 
To prohibit a user whose name has been associated with data from logging on to 
GTGS, you must deactivate them. See Deactivating Users on page 133.

To delete a user:

1. Open the menu and select Users.

2. Select the user name.

3. Do one of the following:
• Open Edit → Delete.
• Right-click the user name and select Delete (Figure 5.4).

4. At the confirmation prompt, click Yes.

Figure 5.3
New User Displayed in Users Window

Figure 5.4
Deleting a User
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Changing Users

While using the software, you can switch from one user name to another without 
logging out by using the Set User command.

To change users:

1. Open the menu and select Users.

2. Open Tools → Set User …

3. Open the User Name menu and select a user.

4. Click OK.

Deactivating Users

Users can be deactivated to prohibit them from logging in to GTGS. This 
functionality is useful when a user has experiments or data associated with their name 
and therefore cannot be deleted. You must be logged in as admin to deactivate users.

To deactivate a user:

1. Log on to GTGS or Set User as admin.

2. Open the menu and select Users.

3. Do one of the following:
• Select the user name and open Tools → Deactivate.
• Right-click the user name and select Deactivate.

As shown below, notice there is now a Y in the InActive column for that particular 
user.

Activating Users

You must be logged in as admin to activate users.

To activate a user that has been deactivated:

1. Log on to GTGS or Set User as admin.

2. Open the menu and select Users.

3. Do one of the follow:
• Select the user name and open Tools → Activate.
• Right-click the user name and select Activate.

Notice that the Y in the InActive column has been removed. The user status is now 
active.

Figure 5.5
Deactivating a User
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Modifying User Properties

If you are logged in as admin, you can change the user name and description. If you 
are logged in as the user, you can modify the user description only.

To modify user properties:

1. Do one of the following:
• Select the user name and open Edit → Properties.
• Right-click the user name and select Properties.

2. Edit the user properties as permitted.

3. Click Save.

Exporting a List of Users

You can export the display in the right pane of the Users window as a text file.

To export a list of users:

1. Open File → Export Table.

2. Browse to the location where you want the file saved.

3. In the File name field, enter a name for the text file.

4. Click Save.
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PROTOCOL MANAGEMENT

A protocol designation must be entered into GTGS before samples can be processed 
using the MIP Assay Protocol. When running the protocol in the lab, users are asked 
to enter a protocol barcode. Entering the protocol barcode enables future users to see 
which procedure was followed in the lab when processing a particular set of samples. 

Protocol management functions include:

• Adding protocols

• Deleting protocols (if the protocol has not been used)

• Modifying protocol properties

Adding Protocols
To add a protocol:

1. Open the menu and select Protocols.

2. Select the Protocols folder and do one of the following:
• Open File → New Protocol.
• Right-click the Protocols folder and select New Protocol (Figure 5.6).

3. In the Protocol Creation Dialog window:

A. In the Name field, enter a name for the protocol.

B. Optional: In the Description field, enter a description for the protocol.

C. Click the Barcode tab.

D. In the Enter Barcode field, scan or type a barcode for the protocol.
Barcodes must contain the prefix PCL_. A barcode for the MIP Assay Protocol 
is provided on the quick reference card, MIP Assay Protocol Barcodes. Barcode 
designations entered here are associated with experiments run in the laboratory 
using the same protocol.

Figure 5.6
Add a New Protocol
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4. Click Save.

The protocol properties are displayed in the right pane of the Protocols window.

Deleting Protocols

You can delete a protocol only if it is not associated with any experiments or data.

To delete a protocol:

1. Open the menu and select Protocols.

2. Do one of the following:
• Select the protocol name and open Edit → Delete.
• Right-click the protocol name and select Delete.

3. At the Confirm Deletion prompt, click Yes.

Modifying Protocol Properties

You can modify the name and description of a protocol. You cannot modify the 
protocol barcode.

To modify protocol properties:

1. Open the menu and select Protocols.

2. Select the protocol name and do one of the following:
• Open Edit → Properties.
• Right-click the protocol name and select Properties.

3. Modify the protocol name or description.

4. Click Save.

Figure 5.7
Entering New Protocol Information

Figure 5.8
New Protocol Displayed in Protocols Window
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Exporting a List of Protocols

You can export the display in the right pane of the Protocols window as a text file.

To export a list of protocols:

1. Open the menu and select Protocols.

2. Open File → Export Table.

3. Browse to the location where you want the file saved.

4. In the File name field, enter a name for the text file.

5. Click Save.
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ARRAY DEFINITION MANAGEMENT

An array definition file identifies each feature on an array. Based on this file, the 
software is able to distinguish control features from genotyping features. You cannot 
analyze data on an array if the corresponding array definition file is not present in the 
software.

Array definitions are installed during GTGS installation and configuration. If your 
assay panel uses an array type not yet defined in the software, you will need to import 
it before proceeding with the MIP Assay Protocol.

Array definition management functions include:

• Adding array definitions

• Deleting array definitions

• Modifying array definition properties

Adding Array Definitions

1. Load the array definition CD-ROM onto the appropriate computer.

2. In GTGS, open the menu and select Array Definitions.

3. Do one of the following:
• Open File → Import Array Definition.
• Right-click the Array Definitions folder and select Import Array Definition.

4. In the Array Definition File window, locate the filename and select it.

5. Click Open, then click OK.

Notice the array definition is now displayed (Figure 5.9).

Deleting Array Definitions

An array definition cannot be deleted once an assay panel that references the definition 
is imported.

To delete an array definition:

1. In the software, open the menu and select Array Definitions.

2. Do one of the following:
• Select an array name and open Edit → Delete.
• Right-click the array name and select Delete.

3. Click Yes.

Figure 5.9
Adding an Array Definition
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Modifying Array Definition Properties

You can modify the description of an array definition.

To modify the description of an array definition:

1. In the software, open the menu and select Array Definitions.

2. Select an array name.

3. Do one of the following:
• Open Edit → Properties.
• Right-click the array name and select Properties.

4. Enter or modify the description.

5. Click Save.

Displaying Array Definition Details and Features

You can display general details about a particular array definition such as the number 
of features on that type of array. You can also display details about the features of a 
particular array type such as the Feature ID and Tag ID.

To display array definition details:

1. Open the menu and select Array Definitions.

2. Select the Array Definitions folder. 

3. Click the Arrays Definition Details tab.

Details are displayed in the right pane.

To display feature information for a particular type of array:

1. Open the menu and select Array Definitions.

2. Select an array definition name.

As shown below, information for each feature on the array is displayed in the right 
pane of the window.

Figure 5.10
Displaying Array Definition Details
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Exporting a List of Array Definitions

You can export the information in the right pane of the Array Definitions window as 
a text file.

To export a list of array definitions:

1. Open the menu and select Array Definitions.

2. Select the Array Definitions folder.

3. Open File → Export Table.

4. Browse to the location where you want the file saved.

5. In the File name field, enter a name for the text file.

6. Click Save.

Exporting A List of Array Features

You can export a list of the features for a particular array as a text file.

To export a list of array features:

1. Open the menu and select Array Definitions.

2. Select the name of an array.

3. Open File → Export Table.

4. Browse to the location where you want the file saved.

5. In the File name field, enter a name for the text file.

6. Click Save.

Figure 5.11
Feature Information for a Particular Type of Array

Numerical value for 
each feature

X and Y coordinates 
of feature on the array Universal Tag Array

Identifier for each 
tag on the array
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Project Management

ABOUT PROJECTS

In GTGS, sample tracking information is organized in folders called projects. Each 
project contains information about all of the samples that have been tested (or will be 
tested) using a specific assay panel.

Each project you create will ultimately contain the following information:

• Sample Plates
Contains information on the sample plates to be used for a particular project. 
Information includes the sample plate barcode, sample names and well contents.

• Anneal Plates
Contains information used to determine which samples are to be transferred:

- First, from a specific Sample Plate to a specific Anneal Plate. 

- Then from the Anneal Plate to a specific Assay Plate.
Information includes Sample, Anneal and Assay Plate barcodes, and well or row 
designations on all plates.

• Assay Plates
Contains information used to determine which samples are to be transferred:

- First from a specific Anneal Plate to a specific Assay Plate. 

- Then from the Assay Plate to a specific Label Plate.
Information includes Anneal, Assay, and Label Plate barcodes, and well or row 
designations on all plates.

• Label Plates
Contains information used to determine which samples are to be transferred:

- First from a specific Assay Plate to a specific Label Plate. 

- Then from the Label Plate to a specific Hyb Plate.
Information includes Assay, Label, and Hyb Plate barcodes, and well or row 
designations on all plates.

• Hyb Plates
Contains information used to determine which samples are to be transferred:

- First from a specific Label Plate to a particular Hyb Plate. 

- Then from the Hyb Plate to a specific array.
Information includes Label Plate, Hyb Plate and array barcodes, and well or row 
designations on all plates.

• Arrays
Contains information on the arrays used for a particular project including the array 
barcode and the date the barcode was scanned.
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ARRAY DEFINITIONS AND ASSAY PANELS

An array definition for the type of array referenced by an assay panel must be imported 
into GTGS before you can import the panel information.

DELETE FUNCTIONALITY

Project components must be deleted in the reverse order of how they were added. 

You must be logged in as admin to delete arrays. See Deleting Projects and Project-Related 
Information Deleting Projects and Project-Related Information on page 104.

EXPORT FUNCTIONALITY

You can export any project information displayed in the right pane as text file. An 
example of what would be exported from the Sample Plates window is shown in 
Figure 5.12.

To export project information:

1. Navigate to the window with the desired information.

2. Open File → Export Table.

3. Navigate to the location where you want the text file saved.

4. In the File Name field, enter a name for the text file.

You do not need to add the extension .txt.

5. Click Open.

Figure 5.12
Exporting Sample Plate Information

The information that would be exported is outlined in red.
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Vendor Contact Information
Customers outside the United States should check each vendor’s website for
additional contact information.

Table A.1
Vendor Contact Information

Company Address Telephone

Affymetrix
www.affymetrix.com

3380 Central Expressway
Santa Clara, California 95051

U.S. 1-888-362-2447
U.K. +44 (0)1628 552550
Japan +81-3-5730-8222

Applied Biosystems
www.appliedbiosystems.com

850 Lincoln Centre
Foster City, California 94404

1-800-327-3002
1-650-638-5800

Axygen Scientific, Inc.
www.axygen.com

33210 Central Ave.
Union City, California 94587

1-800-4-AXYGEN
1-510-494-8900

Distributors for Barcoded 96-Well PCR Thermal Cycler Plates and Barcode Labels (Anneal, Assay, Label, Hyb)
For distributors in countries not listed, refer to:www.axygen.com/Distributors

U.S.A.
E & K Scientific, Inc.
3575 Thomas Road
Santa Clara, California 95054
www.eandkscientific.com

Tel: 1-800-934-8114 or 1-408-378-2013
Fax: 1-408-378-2611

Australia
Radiometer Pacific P/L PO Box 47
Nunawading
Vic 3131
oceania1.radiometer.com

Tel: [61] 39-7063-655
Fax: [61] 39-7063-755 

Canada
Ultident Scientific
4850 Chemin Bois Franc Suite 100 
St. Laurent, Quebec H4R 2G7 
www.ultident.com

Tel: 514-335-3433
Fax: 514-335-0992

Germany
G.Kisker GbR
Produkte f.d. Biotechnologie Postfach 1329
48543 Steinfurt
www. kisker-biotech.com

Tel: [49] 02551-864310
Fax: [49] 02551-864312

Japan
Funakoshi Co Ltd.
9-7. Hongo 2-Chome
Bunkyo-Ku 
Tokyo 113-0033 
www.funakoshi.co.jp

Tel: [81] 3-5259-5901
Fax: [91] 3-5259-1005
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Singapore
Bio Laboratories 
10 Ubi Crescent. Lobby A #06-02. Ubi 
Techpark 408564  
www.biolab.com.sg

Tel: [65] 6846-7577
Fax: [65] 6846-7477

United Kingdom
Thistle Scientific Ltd.
DFDS House 
Goldie Road Uddingston. 
Glasgow G71 6NZ 

Tel: [44] 169-833-8844
Fax: [44] 169-833-8880

Bio-Rad Laboratories
www.biorad.com

2000 Alfred Nobel Dr.
Hercules, California 94547

Life Science Research Group
1-800-424-6723
1-510-741-1000

BioSmith Biotech
www.biosmith.com

3649 Conrad Ave.
San Diego, California 92117

1-800-929-7894
1-858-270-8389

Clontech, a TAKARA BIO 
Company
www.clontech.com/clontech

1290 Terra Bella Avenue 
Mountain View, CA 94043
USA

1-800-662-2566
1-650-919-7300

Coriell Cell Repositories
http://locus.umdnj.edu/ccr/

403 Haddon Avenue
Camden, NJ 08103

Tel: 1-800-752-3805
Fax: 1-856-757-9737

Eppendorf
U.S. only: www.eppendorfna.com
Also available through distributors

One Cantiague Road
P.O. Box 1019
Westbury, NY 11590-0207

1-800-645-3050

Gilson
www.pipetman.com

3000 W. Beltline Hwy.
P.O. Box 620027
Middleton, WI 53562-0027

1-800-GILSON1 or 1-608-836-1551

Invitrogen Life Technologies
www.invitrogen.com

1600 Faraday Ave.
P.O. Box 6482
Carlsbad, California 92008

1-760-603-7200

Rainin Instrument, LLC
www.rainin.com

7500 Edgewater Dr.
P.O. Box 2160
Oakland, California 94621

1-800-472-4646
1-510-564-1600

Stratagene
www.stratagene.com

11011 North Torrey Pines Rd.
La Jolla, California 92037

1-858-535-5400

USA Scientific, Inc
www.usascientific.com

P.O. Box 3565
Ocala, Florida 34478

U.S.: 1-800-522-8477
International: 1-352-237-6288

VWR International
www.vwr.com

1310 Goshen Pkwy.
West Chester, Pennsylvania 19380

1-800-932-5000

Table A.1
Vendor Contact Information

Company Address Telephone
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Thermal Cycler Programs
The MIP Assay Protocol has been optimized for use with the 96-well GeneAmp® PCR 
System 9700 Thermal Cyclers (silver block) manufactured by Applied Biosystems. 
Equivalence tests have been run on the other models listed in Chapter 2, Equipment, 
Supplies, Consumables.

Five thermal cycling programs are used throughout the protocol. This appendix 
briefly describes each of these programs. It also includes step-by-step instructions for 
programming the Meg 22 (20) cycle programs.

PRE-AMP LAB THERMAL CYCLER PROGRAMS

Only the GeneAmp PCR System 9700 Thermal Cyclers are approved for use in the 
Pre-Amp Lab. These thermal cyclers must be set up to run the following programs:

• Meg Anneal

• Meg 22 (20) cycle programs

- Meg 3-5-10k

- Meg 20k

POST-AMP LAB THERMAL CYCLER PROGRAMS

The thermal cyclers listed under Thermal Cyclers on page 13 can be used in the Post-
Amp Lab. These instruments must be set up to run the following programs:

• Meg Hypcr programs

- Meg Hypcr 3-5k

- Meg Hypcr 10-20k

• Meg Hydigest-a

• Meg Denature

SETTING THE RAMP SPEED AND VOLUME FOR EACH PROGRAM

Ramp Speeds

Use the following ramp speeds for the thermal cyclers validated for use with the 
Affymetrix GeneChip® Scanner 3000 Targeted Genotyping System.

• GeneAmp PCR System 9700 Thermal Cycler with a gold or silver block: Max

• GeneAmp PCR System 9700 Thermal Cycler with an aluminum block: Std

• GeneAmp PCR System 9700 Thermal Cycler with a dual block: 96D

• DNA Engine® Peltier and Dyad: Gradient

The first time you run each of these programs, you must change the default ramp
speed and volume settings.
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Setting Ramps Speeds and Volumes

The following instructions are for programming a GeneAmp PCR System 9700 
thermal cycler with a gold or silver block.

To set the ramp speed and volume for each program:

1. Press Run (F1).

2. Use the arrow pad to select the program.

3. Press Start (F1).

4. Press the down arrow to move to the ramp speed.

5. Press Max (F3).

Max is the ramp speed to use for GeneAmp PCR System 9700 thermal cyclers with 
a gold or silver block. For other cycler ramp speeds, see Ramp Speeds above.

6. Press the up arrow to move to the reaction volume and enter the volume 
appropriate volume:

• Meg Anneal: 45

• Meg 3-5-10k and Meg 20k: 67

• Meg Hypcr 3-5k and Meg Hypcr 10-20k: 35

• Meg Hydigest-a: 75

• Meg Denature: 90

7. Press Start (F1) to start the program.
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Meg Anneal Thermal Cycler Program

ABOUT THE MEG ANNEAL PROGRAM

The Meg Anneal program consists of three holds and no cycles.

Ramp speed and volume:

• Ramp speed

- GeneAmp PCR System 9700 with a gold or silver block = Max

- GeneAmp PCR System 9700 with an aluminum block = Std

• Volume: 45 μL

The ramp speed and volume must be set the first time you use the program. See
Setting the Ramp Speed and Volume for Each Program on page 148.

Table B.1
Stages of the Meg Anneal Thermal Cycler Program

Stage Temperature Time

Enzyme A 20°C 4 minutes

Denature 95°C 5 minutes

Anneal 58°C Infinity

Figure B.1
Meg Anneal Thermal Cycler Program
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Figure B.2
Thermal Cycler Display for the Meg Anneal Program
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Meg 22 (20) Cycle Thermal Cycler Programs

ABOUT THESE PROGRAMS

Meg 3-5-10k and Meg 20k are two variations of the same thermal cycling program. 
The difference between these programs is the number of cycles used for the denature, 
anneal and extend stages at the end of the program (Table B.2). The version that you 
will use is determined by the assay panel size. The only difference between these 
programs is the number of amplification cycles performed.

• For 3K, 5K and 10K assay panels: use Meg 3-5-10k (22 cycles)

• For 20K assay panels: use Meg 20k (20 cycles)

Ramp speed and volume for both programs:

• Ramp speed

- GeneAmp PCR System 9700 with a gold or silver block = Max

- GeneAmp PCR System 9700 with an aluminum block = Std

• Volume: 67 μL

The ramp speed and volume must be set the first time you use the program. See
Setting the Ramp Speed and Volume for Each Program on page 148.

Table B.2
Stages of the Meg 22 (20) Cycle Thermal Cycler Programs

Stage Temperature Time Cycles

Gap Fill/Split 58°C 2 minutes

dNTP Mix/Anneal 58°C 10 minutes

Ligate 58°C 10 minutes

Exo 37°C 15 minutes

Denature 95°C 5 minutes

Cleavage Mix 37°C 10 minutes

Amp Mix 60°C 2 minutes

Denature 95°C 10 minutes

Denature 95°C 20 seconds
3K/5K/10K: 22 cycles

20K: 20 cyclesAnneal 64°C 45 seconds

Extend 72°C 10 seconds

Finish
72°C 10 seconds

4°C Infinity
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TO SET UP THE MEG 22 (20) CYCLE PROGRAMS

The GeneAmp PCR 9700 thermal cyclers accept six holds only. Because these 
programs include 10 holds, the instrument must be programmed using an 
unconventional method. Essentially the thermal cycler is programmed to accept two 
high-level hold programs: one with 6 holds; the other with 2 holds.

To set up the Meg 22 (20) cycle programs, you will:

• Insert an additional cycle program

• Change one of the cycles to a hold and create the first 8 holds

• Set the temperatures and times for the first 8 holds

• Set the temperatures and times for the amplification cycle

• Set the temperatures and times for the last 2 holds

• Store the program

Figure B.3
Meg 22 (20) Cycle Thermal Cycler Programs
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Insert Addition Cycle Program

To insert an additional cycle program:

1. Turn on the thermal cycler.

2. Press F2 to select Create.

The generic program appears. The 1 of 1 Hld is highlighted.

3. Press the down arrow to highlight 94.0 and display different options above the 
function keys.

Figure B.4

Figure B.5

Figure B.6

Different options
displayed
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4. Press F4 to select More.

5. Press F2 to select Insert.

6. Press F2 to select Cycle.

Figure B.7

Figure B.8

Do not choose Hold. Selecting Hold will not insert an additional hold step into the
program.

Figure B.9
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Now the generic program displays two cycle programs (3 Tmp 25 Cycles) 
separated by one hold (1 Hld).

Change the First Cycle Program to a Hold and Create the First 8 Holds

To change the first cycle program to a hold and set up the first 8 holds:

1. Press the up arrow to highlight the 3 of the first 3 Temp 25 Cycles.

2. Using the keypad, change the 3 to a 1.

3. Press the down arrow.

Figure B.10

Figure B.11

Figure B.12
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The wording in the display changes from 3 Temp 25 Cycles to 1 Hld.

4. Using the keypad, change the 1 to a 6.

5. Press the right arrow twice to move the highlight to the second hold program 
(immediately adjacent to the first 6-stage hold just created).

Figure B.13

Figure B.14

Figure B.15
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6. Using the keypad, change the 1 to a 2.

Set the Times and Temperatures for the 6 Pre-PCR and 2 Hld 
Programs

1. Press the down arrow once, then the left arrow repeatedly to move from the 2 of 2 
Hld back to the 94.0 of the 6 Pre-PCR program.

2. Using the keypad, change 94.0 to 58.0.

Figure B.16

Figure B.17

Figure B.18
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3. Press the down arrow to highlight 0:30; then use the keypad to change 0:30 to 
2:00.

4. Continue using the arrow keys and keypad to change each time and temperature 
in the 6 Pre-PCR and 2 Hld programs to those shown below.

Figure B.19

Figure B.20

Note The last hold is not visible in the display as shown above. 
You must use the right arrow key to move to the last hold 
and set the temperature and time.
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Set Up the Amplification Cycle

To set up the amplification cycle:

1. Continue using the arrow keys and keypad to set the temperature and duration of 
each PCR cycle as follows:

Program the Last Two Holds

To program the last two holds:

1. Continue using the arrow keys and keypad to advance to the ninth hold and set it 
to 72°C for 10 seconds.

2. Advance to the last hold and set it to 4°C for Infinity.

Store the Program

To store the program:

1. Press F2 to select Store.

2. If the User designation is:

• Correct, proceed to the next step.

• Incorrect, press F2 and select the correct user.

3. Press F1 to select Accept.

4. Press F3 to select Method.

5. Press CE on the keypad to clear.

6. Use the arrows to move to the letter m, then press Enter on the keypad.

7. Continue entering the program name in the same manner (meg 3-5-10k or 
meg 20k).

• To select numbers (22 or 20), press the corresponding numbers on the keypad.

• To include a space, move to and enter the blank after the letter z.

8. Press F1 to select Accept.

9. Press F1 again to select Accept.

Table B.3

Temp of PCR Cycle Temperature Time Cycles

Temp 1 (Denature) 95°C 20 seconds
Meg 3-5-10k: 22 cycles

Meg 20k: 20 cyclesTemp 2 (Anneal) 64°C 45 seconds

Temp 3 (Extend) 72°C 10 seconds

Note: Because the products being amplified are <120 bases in length, long extension times are not 
required.
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SET THE RAMP SPEED AND VOLUME

The ramp speed and volume for all of these programs are:

• Ramp speed

- GeneAmp PCR System 9700 with a gold or silver block = Max

- GeneAmp PCR System 9700 with an aluminum block = Std

• Volume: 67

The ramp speed and volume must be set the first time you use the program. See
Setting the Ramp Speed and Volume for Each Program on page 148.
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Meg Hypcr Thermal Cycler Programs

ABOUT THE MEG HYPCR PROGRAMS

Each of the Meg Hypcr programs consist of three holds and 1 cycle. The only 
difference between these programs is the number of cycles. The version you will use is 
determined by the assay panel size.

• For 3K and 5K assay panels, use Meg Hypcr 3-5k (9 cycles)

• For 10K and 20K assay panels, use Meg Hypcr 10-20k (10 cycles)

Ramp speeds:

• GeneAmp PCR System 9700 Thermal Cycler with a gold or silver block: Max

• GeneAmp PCR System 9700 Thermal Cycler with an aluminum block: Std

• GeneAmp PCR System 9700 Thermal Cycler with a dual block: 96D

• DNA Engine Peltier and Dyad: Gradient

Volume: 35 μL

The ramp speed and volume must be set the first time you use the program. See
Setting the Ramp Speed and Volume for Each Program on page 148.

Table B.4
Stages of the Meg Hypcr Thermal Cycler Programs

Stage Temperature Time Cycles

Denature 95°C 10 minutes

Denature 95°C 20 seconds
3K/5K: 9 cycles

10K/20K: 10 cyclesAnneal 68°C 45 seconds

Extend 68°C 10 seconds

Finish 68°C 10 seconds

Standby 4°C Infinity
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Figure B.21
Meg Hypcr Thermal Cycler Programs

Figure B.22P
Thermal Cycler Display for the Meg Hypcr 3-5k Program

Figure B.23
Thermal Cycler Display for the Meg Hypcr 10-20k Program
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Meg Hydigest-A Thermal Cycler Program

ABOUT THE MEG HYDIGEST-A PROGRAM

The Meg Hydigest-a program consists of three holds and no cycles.

Ramp speeds:

• GeneAmp PCR System 9700 Thermal Cycler with a gold or silver block: Max

• GeneAmp PCR System 9700 Thermal Cycler with an aluminum block: Std

• GeneAmp PCR System 9700 Thermal Cycler with a dual block: 96D

• DNA Engine Peltier and Dyad: Gradient

Volume: 75 μL

The ramp speed and volume must be set the first time you use the program. See
Setting the Ramp Speed and Volume for Each Program on page 148.

Table B.5
Stages of the Meg Hydigest-a Thermal Cycler Program

Stage Temperature Time

Digestion 37°C
30 minutes

60 minutes

Heat Inactivation 95°C 5 minutes

Standby 4°C Infinity

Figure B.24 
Meg Hydigest-a Thermal Cycler Program

If running a second QC gel, remove 
4.0 μL of each sample when timer 
reads 5:00 min remaining for the 
second 37°C hold.
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Figure B.25 
Thermal Cycler Display for Meg Hydigest-a Program
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Meg Denature Thermal Cycler Program

ABOUT THE MEG DENATURE PROGRAM

The Meg Denature program consists of two holds and no cycles.

Ramp speeds:

• GeneAmp PCR System 9700 Thermal Cycler with a gold or silver block: Max

• GeneAmp PCR System 9700 Thermal Cycler with an aluminum block: Std

• GeneAmp PCR System 9700 Thermal Cycler with a dual block: 96D

• DNA Engine Peltier and Dyad: Gradient

Volume: 90 μL

The ramp speed and volume must be set the first time you use the program. See
Setting the Ramp Speed and Volume for Each Program on page 148.

Table B.6 
Stages of the Meg Denature Thermal Cycler Program

Stage Temperature Time

Denature 95°C 6 minutes

Standby 4°C Infinity

Figure B.26M
Meg Denature Thermal Cycler Program
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Figure B.27 
Thermal Cycler Display for the Meg Denature Program
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Guidelines for Increasing Sample Throughput
This appendix provides guidelines for increasing sample throughput for the MIP 
Assay Protocol from 48 to 96 samples per day based on a five day work week.

EQUIPMENT RECOMMENDATIONS

Increasing sample throughput based on the workflow recommended in Figure C.1 on 
page 171 requires the following additional equipment. Refer to Chapter 2, Equipment, 
Supplies, Consumables for part numbers.

• One additional thermal cycler in the Pre-Amp Lab (or an incubation block)
GeneAmp® PCR System 9700 Thermal Cycler

• One additional GeneChip® Hybridization Oven 640 with 8 carriers

• One to two additional GeneChip® Fluidics Station 450

RESOURCE REQUIREMENTS

Increasing sample throughput based on the workflow recommended in Figure C.1 
requires one additional FTE (for a total of 3 FTEs). FTEs must be available to process 
samples a minimum of 8 hours per day.

The process itself requires a minimum of 10 hours per day.

SUGGESTED WORKFLOW

The workflow shown in Figure C.1 on page 171 requires:

• That operators be proficient with running the MIP Assay Protocol.

• That every resource and all equipment is readily available and functional.

• A third thermal cycler or incubation block in the Pre-Amp Lab. This cycler is used 
to hold the second round of annealed samples at 58°C until the thermal cyclers in 
the Post-Amp Lab are available for use.

• Scanning 9 hours per day, assuming that new arrays are added to the Autoloader 
every 30 minutes. In addition, the scanner must be left to run overnight.
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Figure C.1
Suggested Workflow for Processing 96 Samples Per Day
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How to Change Plate Barcode Restrictions
This appendix describes how to change the default barcode restrictions required by 
Affymetrix GeneChip® Targeted Genotyping Analysis Software (GTGS). The default 
barcode designations correspond to the names of the various plates used for sample 
processing:

• Ann = Anneal Plate

• ASY = Assay Plate

• LBL = Label Plate

• Hyb = Hyb Plate

These designations help to ensure that the samples loaded onto each plate are properly 
tracked throughout the MIP Assay Protocol.

To change the default barcode properties, modify the AssayTracking.properties file by 
changing the designations highlighted below. The location of this file is:

C:\Program Files\Apache Group\Tomcat 4.1\webapps\geno\config\ Assay Tracking.properties

# Defines plate tracking properties while performing assay

# Required barcode prefixes:

# Anneal plate:
ann-plate.pattern = ANN.*
ann-plate.errmsg = Barcode must start with ANN

# Assay plate:
asy-plate.pattern = ASY.*
asy-plate.errmsg = Barcode must start with ASY

# Label plate:
lbl-plate.pattern = LBL.*
lbl-plate.errmsg = Barcode must start with LBL

# Hybridization plate:
hyb-plate.pattern = HYB.*
hyb-plate.errmsg = Barcode must start with HYB

# Protocol:
protocol.pattern = PCL.*
protocol.errmsg = Barcode must start with PCL

The default barcode designations for plates help to ensure that the samples loaded
onto each plate are properly tracked throughout the MIP Assay Protocol. Therefore
we recommend that you do not change the default barcode designations.

Modify only the text that is highlighted. Do not change the .*
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# Valid Thermal Cyclers (leave blank for no checking)
# use comma delimited integers for specific thermal cyclers (e.g. 1, 2, 3) 
ann-plate.thermal-cyclers =
asy-plate.thermal-cyclers =
lbl-plate.thermal-cyclers =
hyb-plate.thermal-cyclers =
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